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This software is furnished in accordance with a separate license agreement included with the software, 
and subject to any restrictions set forth therein. For more information about Onset's licensing terms and 
policies, contact Onset Customer Service at 1-800-LOGGERS, or visit http://www.onsetcomp.com/legal. 
 

Thank you for purchasing Onset® products. Our loggers and software are designed to be easy to use, with 
many powerful capabilities.  
 
Contact Information 
For support, please contact the company that you bought the products from: Onset Computer Corporation or an 
Onset Authorized Dealer. 

Onset Computer Corporation 
470 MacArthur Blvd. 
Bourne, MA 02532 

Mailing Address:  
P.O. Box 3450 
Pocasset, MA 02559-3450 

Phone: 1-800-LOGGERS (1-800-564-4377) or 508-759-9500 
Fax: 508-759-9100 
Hours of Operation: 8 AM to 5 PM ET, Monday through Friday 

E-mail: loggerhelp@onsetcomp.com 
Main Onset Web site: http://www.onsetcomp.com 

© 2003 – 2008 Onset Computer Corporation. All rights reserved. 
 

Onset, HOBO, HOBOware, BoxCar, FlexSmart, Energy Logger Pro, and GreenLine are trademarks or 
registered trademarks of Onset Computer Corporation for its data logger products and configuration/interface 
software. Macintosh is a registered trademark of Apple, Inc. Microsoft, Windows, Excel, and PowerPoint are 
registered trademarks of Microsoft Corporation. Keyspan is a trademark of InnoSys Inc. All other trademarks 
are the property of their respective companies. 
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In t roduc t ion  to  HOBOware  Pro  

Overview 

HOBOware Pro combines fast, easy logger launch and readout functions with powerful data plotting 
capabilities, making it easier than ever for users to analyze environmental conditions recorded with HOBO 
loggers.  

An intuitive, graphical user interface allows users to select environmental parameters to display, format 
graphs, perform analysis, and save projects for future use. HOBOware Pro supports one-click export of 
data to Microsoft® Excel or other ASCII-compatible programs.  

HOBOware Pro incorporates valuable capabilities such as scaling data to sensor units and saving graphs so 
they can be recalled and used in the future. HOBOware Pro also provides capabilities to support 21 CFR 
Part 11 compliance.  

Optional tools for real-time data readout, alarms, and post processing of data provide users with even 
greater insight into their data. 

Supported Devices 

HOBOware Pro is compatible with the following HOBO data loggers:   

• HOBO U-Series loggers 

• HOBO Weather Stations 

• HOBO Micro Stations 

• HOBO Energy Logger Pro Systems 

• HOBO U-Shuttle and Waterproof Shuttle 

• HOBO FlexSmart Modules 

 Features 

• Setup Assistant 

• Easy device setup/launch 

• Graphing and analysis with ability to view multiple data files on one graph 

• Filters to extract key series information such as minimum/maximum values. 

• Save Project Changes 

• Import and Export ASCII text data 

• Check Logger Status and view current readings 

• Time-saving options for launch, readout and opening files 

• Access remote loggers through Ethernet (requires supported Ethernet Server) 

• Included Data Assistants for Linear Scaling, Pulse Scaling, and kWh 

• Optional Data Assistants for Grains per Pound and Growing Degree Days 

• Subset Statistics Tool (included with software) 
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• Bulk Export Tool (included with software) 

• Optional Alarm Readout Tool (purchased separately) 
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GETTING STARTED  

Ins ta l l i ng  HOBOware  Pro  

Before You Begin 

Refer to the README file on the installation CD for detailed information about the hardware and software 
needed to run HOBOware Pro. If you have additional questions, please check the HOBOware website at 
http://www.onsetcomp.com/products/software, or call Onset Technical Support. 

Java 

HOBOware Pro requires the Java 2 Runtime Environment. If the correct Java 2 Runtime Environment 
version is not already installed on your computer, the HOBOware Pro Setup program will ask if you want 
to install it. Click Yes and follow the prompts. You must be logged in as an administrator on your 
computer to install the Java 2 Runtime Environment. 

Steps 

1. Insert the CD in your computer’s CD-ROM drive.  

The installation program should start automatically. If it does not, navigate to the CD drive in My 
Computer or Windows® Explorer and double-click HOBOware Pro_Setup.exe to launch the 
installer. 

2. Follow the prompts.  

HOBOware will open automatically when the installation is complete (unless you uncheck the Launch 
HOBOware Pro box on the final dialog before clicking Finish).  

If HOBOware does not open automatically, double-click the HOBOware icon on your desktop or Quick 
Launch menu. Or, from the Start menu, select Programs> Onset Applications > HOBOware ProLite.  

  



- 9 - 

HOBOware  Se tup  Ass i s tan t  
When you open HOBOware Pro for the first time, you are greeted by the HOBOware Setup Assistant, 
which allows you to change some key preferences. To run the Setup Assistant, click Start and follow the 
prompts. 

NOTE: The Setup Assistant is optional. If you click Cancel, you will be able to use HOBOware with its 
default settings, as listed below. To run the Setup Assistant at any time, go to the File menu and select 
Preferences and  click the Setup Assistant button in the bottom right of the pane. 

 To see all of the preferences you can configure, go to the File menu and select Preferences. 

Setup Assistant Panes 

* Default Setting 

Pane 1: Device Types 

Serial Port(s) to use:  

Support serial devices on COM1. 

Pane 2: Unit System 

• US * 

• SI 

Pane 3: Data Assistants 

Select the installed Data Assistants you want to show when relevant data is present.  

All loaded Data Assistants are checked by default. 

You can also load a new Data Assistant. 
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HOBOware  Tu tor ia l  
After you have installed and opened the HOBOware Pro software and connected a logger, follow these 
steps for a quick tutorial on launching and collecting data with a logger: 

Launch 

1. Click the Launch icon  on the toolbar. This displays the logger's Launch window. Launch windows 
vary slightly for each type of logger. 

2. Review the default Launch settings and change them if you wish.  

Enter a new name in the Description field, and select or deselect Channels to Log (or connect 
appropriate sensors, if applicable). Make sure that at least one of the channels you log is a 
measurement of something that will be easy to change, such as light or temperature. Set a short 
(five seconds or less) Logging Interval, and choose the Now launch option. 

3. Click Launch to begin logging. HOBOware Prodisplays the progress of the launch and warns you not 
to unplug the logger while it is being configured.  

Normally, you would unplug the logger at this point and deploy it. For this tutorial, leave the logger 
plugged in. 

View Status 

1. On the toolbar, click the Status icon  to open the Status window. Watch as the Current 
Readings update in real time. 

2. If you are using a U-Series logger that has a button for logging events, press the logger's event 
button for several seconds.  Watch the Current States in the Status window change to Button 
Down. Release the button. Release the button. 

3. Change the sensor readings by changing the conditions. For example, if you are measuring 
temperature, change the temperature reading by holding the logger or sensor in your hands for a 
minute or two. Watch the Current Readings change as the conditions change. 

4. Close the Status window by clicking OK. 

  

Readout/View Data 

1. Click the Readout icon  on the toolbar. Click Stop when HOBOware Pro asks if you want to stop 
the logger before reading out. 

2. After reading out the logger, HOBOware Pro prompts you to save the datafile. Click Save. 

3. Review the settings on the Plot Setup dialog. The channels you enabled in step 2 should be checked, 
along with button and other events (if applicable). Click Plot. 

4. View the results of your deployment. You should see Button Up and Button Down events (if 
applicable) and the graph should reflect the change in conditions that you caused in step 6. 

5. Use the plotting tools on the toolbar to experiment with the many viewing and customization tools 
available within HOBOware Pro. Pause the pointer over each icon on the toolbar for a description of 
each tool.  
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CONNECTING DEVICES  

Connec t ing  Dev i ces  
HOBOware Pro supports the following devices: 

• HOBO U-Series data loggers and shuttles (communicate with the computer by connecting to a USB 
port) 

• HOBO Weather Station * 

• HOBO Micro Station * 

• HOBO Energy Logger Pro loggers * 

* There loggers communicate with the computer by connecting to a serial port (or USB port with 
Keyspan™ serial adapter) 

You can connect most devices to the USB port by using an Onset-supplied USB interface cable. Some 
loggers require an optic USB base station/coupler or serial cable to connect to the computer. Consult the 
manual that came with your device for specific information about required base stations/couplers or 
cables. 

• Connecting a USB Device to HOBOware (page 12) 

• Connecting a Base Station/Coupler to HOBOware (page 13)  

• Connecting a Serial Device to HOBOware (page 14) 

• Connecting Multiple Devices (page 15) 

NOTE: For instructions on connecting HOBOware-compatible shuttles, or using the HOBO Waterproof 
shuttle as a base station, refer to the shuttle's user guide. 



  

- 12 - 

Connec t ing  a  USB  Dev i ce  
NOTE: If you are using a Base Station or Coupler, see Connecting a Base Station or Coupler on page 13.  

To connect a logger or shuttle to HOBOware using a USB cable: 

1. Open HOBOware Pro. 

2. Plug the large end of the USB interface cable into a USB port on the computer. 

3. Plug the small end of the USB interface cable into the port on the device. (Refer to the diagram and 
instructions that came with the device if you need help finding the port.)  

If the device has never been connected to this computer before, it may take some time for the 
computer to detect the new hardware and report that it has connected successfully. One or more 
messages will appear, indicating that new hardware has been found. You may also hear a chime.  

Your computer may tell you to reboot before you can use the device. It is not necessary to reboot. 

When the device is recognized by HOBOware Pro, the right side of the status bar at the bottom of the 
HOBOware Pro window will update to reflect the number of devices connected. At this point, you can begin 
using the device. 

Disconnecting a Device 

To disconnect the device, simply unplug it from the USB cable. Wait for the status bar to update the 
number of devices before continuing. 
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Connec t ing  a  Base  S ta t ion  o r  Coup le r  
To connect a logger to a base station/coupler: 

1. Open HOBOware Pro. 

2. Plug the base station/coupler cable into a USB port on the computer.  

Important: Make sure the base/station coupler is the correct model for the logger you want to use. 
Consult the manual that came with the logger if you are not sure. 

3. If you are connecting a base station/coupler that has never been connected to this computer before, 
it may take some time for the computer to detect the new hardware and report that it has 
connected successfully. One or more messages will appear, indicating that new hardware has been 
found. You may also hear a chime. 

4. Attach the logger to the base station/coupler as described in the documentation that came with your 
logger. 

5. If the logger has never been connected to this computer before, it may take some time for the 
computer to detect the new hardware and report that it has connected successfully. Again, there will 
be one or more messages and possibly a chime indicating that new hardware has been found. (Your 
computer may tell you to reboot before you can use the logger. It is not necessary to reboot.) 

6. When the logger is recognized by HOBOware Pro, the right side of the status bar at the bottom of 
the HOBOware Pro window will update to reflect the number of loggers connected. At this point, you 
can begin using the logger. 

To disconnect a logger, simply unplug it from the base station/coupler. Wait for the status bar to update 
the number of devices before continuing. 

To attach another logger via a base station/coupler, remove the logger, leaving the base station/coupler 
connected. Then connect the next logger. 
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Connec t ing  a  Ser ia l  Dev i ce  to  HOBOware  
To connect a device to a computer using a serial cable: 

1. Open HOBOware Pro. 

2. Plug the 9-pin end of the serial interface cable into a serial port on the computer or Keyspan 
adapter.  

3. Plug the other end of the serial interface cable into the communications port on the device. (Refer to 
the diagram and instructions that came with the device if you need help finding the port.)  

4. Click the Select Device icon  on the toolbar to ensure that the device is listed in the Select Device 
dialog. Click the button next to the device in the dialog, then click OK. 

NOTE: If you are using a serial port other than COM1, you will need to set up HOBOware Pro to use that 
port.  In Preferences, choose the Communications pane and change the Serial Ports setting as needed. 
Note that checking multiple serial ports can cause slow performance, even when no devices are attached. 

The status bar at the bottom of the HOBOware Pro window will update to reflect that the device is 
connected and selected. At this point, you can begin using the device. 

To disconnect the device, simply unplug it from the serial cable.  
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Connec t ing  Mu l t ip le  Dev i ces  
If your computer has multiple USB and serial ports, you can connect multiple devices and work with one 
at a time. When multiple devices are connected, the Select Device window opens every time you select 
Launch, Readout, Stop, or Status. 

Click the button next to a device on the list to select it, then click OK. The selected action will proceed. 

If serial devices are selected in Preferences, it may take some time for HOBOware Pro to scan all of the 
serial ports. You can select the device you want as soon as it is displayed. You do not have to wait for all 
of the ports to be scanned. 

To access the Select Device window at any time, click the Select Device icon  on the toolbar, or 
choose Select Device from the Device menu. 

Verifying Selected Device 

If the Blink Device Light button is available, you can click it to verify that you have selected the 
appropriate device. This briefly illuminates the light on the devices that you have selected.  

If the device does not have a light, or if the light is not visible when the devices is in the base 
station/coupler, simply check the serial number (S/N) on your devices to make sure that it matches the 
one that is selected in this window. 

When the Select Device window is not open, you can check the status bar at the bottom of the screen to 
quickly determine which device is selected. The left side of the status bar indicates the model, description, 
and serial number of the device; the right side indicates the total number of devices connected. 

Serial devices that you have added or removed are not reflected in the device count until you click the 

Select Device icon  on the toolbar to update the device list. 

If you work with multiple U-Series devices frequently, the Default Action option on the Device menu and 
the time-saving preferences may help you work more efficiently.  
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Repeat  Ac t ion  on  Mu l t ip le  U -Ser ies  
Dev i ces  
If you have many U-Series devices, the Default Action option on the Device menu may help you work 
more efficiently. The Default Action function can save you the most time when you are launching many 
loggers, especially if the loggers are the same model and will have similar launch settings. 

NOTE: This feature is available only for U-Series devices. 

Description 

The default Default Action is Do Nothing. If you change it to an action (Launch, Readout, Get Status), 
HOBOware Pro will perform that action each time you connect a device.  

For example, if you choose Readout and connect a logger, HOBOware Pro will read out that logger 
immediately. You can then disconnect that logger, connect another logger, and that logger will be read out 
automatically. If you connect a shuttle, the shuttle's new files will be offloaded automatically. 

Default Action only works when a single device is plugged in. 

Steps  

1. Set the Default Action to Launch. 

2. Go to Preferences > General > Launch Time-Saving Options 

3. Select the Fill launch window with contents of option.  

Each time you connect a logger, the Launch window will open. If the logger is the same model as the last 
logger launched, the Launch window will be filled in with the settings from the previous launch, and an 
indicator on the upper-right corner of the Launch window will remind you that the Previous launch 
preference is in use.  

Important: When you connect a new device for the first time, the Default Action may ignore it. 
After the device has been connected to the computer and disconnected at least once, it should 
always respond to the Default Action.  
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WORKING WITH  A  DEVICE  

Launch ing  a  Dev i ce  
To set up a logger to record data, you must specify several parameters and start or launch the logger.  

To launch a logger: 

1. Before opening HOBOware Pro, check the time on the computer and ensure that it is correct. If it is 
not, update your computer's clock manually or synchronize it with an online time server (if 
available).  

2. Open HOBOware Pro. 

3. Connect the logger to the computer. 

4. Click the Launch icon on the toolbar, or choose Launch from the Device menu. 

5. Different messages may appear, depending on the state of the logger. Answer each of the prompts 
accordingly: 

• A warning appears if the logger has already been launched. Click Yes to continue, or click No 
to cancel. 

• If the logger is a station-type logger and is currently logging, it will STOP logging if you 
click Yes to continue. Click No if you do not want to stop the logger. 

• If the logger is a U-Series logger (other than the HOBO U30 Station) and is currently 
logging, it will continue to log until you click the Launch button on the Launch Logger 
window. 

• For U-Series loggers only (other than the HOBO U30 Station), a warning appears if the logger 
has collected data since its last readout. Click Yes to proceed to the launch window, or click 
No to cancel the launch and read out the data first.  
 
NOTE: Because loggers are tested before shipping, there may be data in your logger the first 
time you launch it. In this case, it is not necessary to read out the logger. Click Yes to 
proceed. 

6. When the Launch window appears, configure the launch parameters as required: 

• Enter a launch description (up to 40 characters) 

• Select the data channels you want the logger to record, if applicable 

• Set the logging and sampling interval(s), if applicable 

• Choose the start mode for the launch — Now, At Interval, Delayed, Trigger (button or 
coupler, if available), or Save Settings (station-type loggers only). 

7. To verify that the sensors are working correctly or to review settings from the previous launch, click 
the Status button.  

8. Click the Launch button. HOBOware Prodisplays the progress of the launch and warns you not to 
unplug the logger while it is being configured. 

NOTE: If the logger is a U-Series logger (other than a HOBO U30 Station) and was already logging from a 
previous deployment, it will not stop logging the previous deployment until you perform this step. Click 
Cancel instead of Launch if you want to continue the previous deployment. 

Once the logger begins logging, it will continue logging until you stop it, the memory is full, or the battery 
runs out 
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Channe l  Con f igura t ion  Gu ide l ines :  
S ta t ion  Loggers  
This topic describes guidelines for the Channels to Log section in the Launch window for Station loggers. 

Some general information is given below, but you should always refer to the documentation that came 
with your logger for detailed information about the channels that are available to you. 

Dew Point 

When a sensor includes both temperature and RH, dew point will be calculated automatically. 

Maximum Channels 

Do not attach more than 15 channels of sensors. The logger cannot accommodate more than 15 channels. 

Battery Channel 

In addition to logging up to 15 channels, the HOBO Energy Logger Pro and HOBO U30 Station can record 
their internal battery channel. (Other sensors must be attached; the logger cannot log battery alone.) The 
logger's battery voltage is recorded at each interval.  

Like the other data channels, logging the internal battery channel consumes some of the logger's memory. 
Unless you are using excitation power or suspect abnormal battery performance, you probably do not 
need to log the battery voltage in loggers other than the HOBO U30 Station. 

Excitation Power 

Always enable the logger's internal battery channel when logging with excitation power. This will enable 
you to determine whether and when excitation power was turned off during a deployment. 
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Mul t ip le  Logg ing  In terva l s  

Overview 

Some loggers support multiple logging intervals, which allow you to define separate intervals for different 
phases of the deployment. 

If your logger supports multiple logging intervals, you will see an Add New Interval button on the 
Launch window for your logger. 

Because internal logger events, such as coupler events, do take up some of the logger's memory, the 
number of samples and end times are only estimates. Frequent events will cause the logger to fill up 
sooner. 

Steps 

To configure multiple logging intervals: 

1. Click the Add New Interval button until you have as many intervals as you want (up to the 
number of intervals supported by the logger).  

2. Set the hours, minutes, and seconds for each interval, and the number of samples you want the 
logger to record at each interval.  

3. Use the Start and End times in the Duration column to help you decide how many samples to 
record at each interval. 

To delete an interval, click the Remove button next to the interval. 
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Fas t  Logg ing  In te rva l s  
Some loggers support fast logging intervals, which allow you to log more than once per second, up to 100 
measurements per second (hertz). If your logger supports fast logging intervals, the Launch window for 
your logger will offer Logging Interval choices of Normal and Fast. 

To use fast logging intervals, click the Fast button. Then choose a logging frequency from the Hertz drop-
down list, or enter the logging interval in decimal form in the Sec field. 

NOTES 

• A logger cannot communicate with a computer or shuttle while it is logging at a fast interval. Once it 
has started logging, if you connect it to a computer, base station, or shuttle to check status or read 
it out, the logger will stop. 

• Be aware that a fast logging interval typically means a very short Logging Duration. Make sure the 
logger will run long enough to collect the data you need. Disabling unnecessary channels will give 
you more time. 

• Because fast logging deployments are so brief, the logger must be launched with a trigger start. 
Follow the instructions that came with your logger for a trigger (coupler or button) start. If the 
logger has a light, the light will flash quickly when logging begins. 
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Alarms  

Overview 

The following loggers support alarms: 

• HOBO® Temperature/Alarm Data Logger (model UA-001) 

• HOBO U14 LCD Logger 

If your logger supports alarms, you will see an Alarms button on the Launch window. 

Built-in alarm indicators are triggered when data is logged above or below values that you define. You can 
set up alarms to be triggered when the data has been above or below an allowed value for a specified 
amount of time, or when the data has been logged above or below an allowed value for a specified 
number of times throughout the deployment.  

NOTE: If you have a HOBOware-compatible logger without built-in alarm capability, you can use Onset's 
Alarm & Readout Tool to monitor loggers for alarm conditions. When alarms are tripped, the software 
notifies you by e-mail, mobile phone text message, or pager. For more information, visit the Onset 
website: www.onsetcomp.com/Products/Product_Pages/hoboware/alarms_software.html. 

Configuring Alarms for the HOBO® Temperature/Alarm Data Logger 

The following procedure is for configuring alarms for the HOBO® Temperature/Alarm Data Logger. For 
U14 alarm configuration, see the HOBO U14 User's Manual. 

To set up the alarms: 

1. Attach the logger and access the Launch window. 

2. Select a channel that supports alarms (it will have a small bell icon  next to it) and click the 
Alarms button. An Alarms dialog will appear. 

3. Select the High Alarm and/or Low Alarm. Use the sliders to set the values that will trigger the 
high and low alarms, or enter the values manually. (If you enter values manually, the software may 
adjust them slightly to the nearest values supported by the logger.) 

4. In the Number of out-of-range samples logged before alarm raised fields, enter the number 
of samples that are needed to trigger each alarm. 

5. Select an alarm mode: 

• Choose Cumulative if you want the alarm to be triggered after a specific number of samples 
have been logged above or below an allowed value, even if the samples are not logged 
consecutively. 

• Choose Consecutive if you want the alarm to be triggered only when the value has been 
above or below an allowed value for a specific amount of time. If the value goes back in range 
before triggering the alarm, the count is reset. 

6. Click OK to return to the Launch window and proceed as usual. The small bell icon will now be 
colored green to indicate that the alarm has been set. Refer to the logger's manual for information 
about how the logger responds when the alarm is triggered. 
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Check ing  Dev i ce  S ta tus  
The Status window displays real-time information about the attached logger, including:  

• state of the logger 

• time logging will begin 

• current readings 

•  logger memory used 

You can check the status for a logger whether it is waiting for logging to begin, actively logging (unless it 
is logging at a fast logging interval), or stopped. 

NOTE: When a Station logger is logging, HOBOware can only display the last sample taken by the logger, 
at the last interval. 

Important: Battery power is drained more rapidly while checking status. Keep this in mind when 
frequently checking status during a deployment. You can significantly reduce the demand on the battery 
by adjusting the Screen Refresh Interval to five seconds or higher (not available on all loggers). 

Steps 

To check the status of a logger: 

1. Connect the logger to the computer. 

2. Click the Status icon  on the toolbar, or choose Status from the Device menu.  
 
You can also access the Status window by clicking the Status button on the Launch window. 
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Read ing  Out  Data  f rom a  Logger  
To retrieve data recorded by a logger, you must read out the logger. Reading out the logger copies data 
from the logger to your computer, allowing you to save the data in a datafile and view the plot. 

During readout, the logger continues to record data unless you have stopped the logger or the logger is 
full. To read out a logger: 

1. Connect the logger to the computer. 

2. Click the Readout icon  on the toolbar, or choose Readout from the Device menu. If the logger 
is still logging, a message asks whether you want to stop the logger. 

Tip: If you do not want to be prompted to stop the logger every time you read out a logging 
logger, go to Preferences > General > Readout Time-Saving Options and deselect the Ask to stop 
logging before reading out a running logger option. 

3. Wait while the data is read out from the logger. 

4. HOBOware Pro prompts you to save the data. Accept the default location and name, or enter a new 
name and click Save.  

By default, the data is saved in the HOBOware folder located in your My Documents folder, with the 
following extensions: 

• Most U-Series Loggers: .hobo or .hsec 

• Station Loggers: .dtf or .dsec  

If you save the file to a different folder, HOBOware Pro will make that folder its new default. 

Tip: If you would like to bypass the Save dialog every time you read out a logger, go to 
Preferences > General > Readout Time-Saving Options and select When saving datafile: 
Automatically save. The file will be saved automatically with a default name (based on the launch 
description), in the default location. 

5. The Plot Setup dialog appears. 

• Select the series you wish to view on the plot. Click each checkbox individually to select or 
clear sensor measurements, states, and events, or click the All or None buttons to select or 
clear all sensor measurements, states, and events. 

• Select the units you want to display for each series, if available. 

• Adjust the time zone offset, if necessary. By default, data is shown in the offset used to launch 
the logger. To select a different offset, enter the hours offset from GMT (UTC) in decimal form. 
(You may find this useful if you logged in multiple time zones, or if you took the logger to a 
different time zone after launching it.) 

• Use data assistants, if applicable, to create additional series.  

6. When you have made your selections, click the Plot button. The plot is displayed. 

Tip: If you never use data assistants or change time zones, and would like to bypass the Plot 
Setup dialog every time you read out a logger, go to Preferences > General > Readout Time-
Saving Options  and select When plotting: Automatically plot (which bypasses the Plot Setup dialog 
and displays the plot with default selections) or Do not plot (if you do not want to display plots 
while reading out loggers).  
 
You can also choose Automatically plot under Open File Time-Saving Options if you would like 
to bypass the Plot Setup dialog when opening datafiles. 
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Stopp ing  a  Dev i ce  
A logger automatically stops recording data when the memory is full (if wrap is not available or not 
enabled) or the battery runs down.  

You can also stop the logger manually at any time with the stop command. 

To stop a logger: 

1. Connect the logger to the computer. 

2. Click the Stop icon  on the toolbar, or choose Stop from the Device menu. 

After the logger has been stopped, the data remains in the logger until the next launch. 
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Work ing  w i th  the  HOBO U30  S ta t ion  
The HOBO U30 Station is designed primarily for use with HOBOlink which allows for continuous logging 
and transmission of data using mobile network technology. There are, however, some features that are 
only accessible through HOBOware Pro, and some recommended guidelines for using HOBOware Pro.  

Overriding HOBOlink 

If you attempt to launch, read out, or check that status of the HOBO U30 Station using HOBOware Pro, 
you may see a message indicating there is already a live HOBOlink session underway. You can choose to 
override the HOBOlink connection and use HOBOware Pro instead.  

Alternatively, you may see a message indicating the HOBO U30 Station is busy and a HOBOware Pro 
session cannot begin. Try again in a few minutes. 

 The readout configuration you define in HOBOlink sets up how frequently the HOBO U30 Station will 
connect to HOBOlink. For example, if you set a connection interval for 4 hours then the HOBO U30 Station 
will contact HOBOlink automatically every 4 hours.  

There may be circumstances in which you want to override this schedule and contact HOBOlink 
immediately. For example, you moved the HOBO U30 Station to a different location and you want to make 
sure it can still connect to HOBOlink, but you don’t want to wait four hours until the next connection. Click 
the Contact HOBOlink button in the Status window to force an immediate connection. 

Which Software to Use 

The following table details when to use HOBOware Pro instead of HOBOlink. 

Launching 

It is strongly recommended that launching be done exclusively through HOBOlink Any launch that you 
have configured with HOBOlink will override the launch parameters set with HOBOware Pro. 

Reading out 

Readouts are done automatically on a schedule that you set with HOBOlink. Use HOBOware Pro to read 
out only if you are conducting a test or if you need an immediate readout. 

Checking status and signal strength 

Check HOBOlink for the latest data, current status, and alarm information.  

Open the Status window in HOBOware Pro if you wish to check how powerful the cellular signal for the 
HOBO U30 Station in the current location. This will help you determine if you need to reposition the 
station for optimal signal strength. 

Configuring the Analog Sensor Port 

This can only be done in HOBOware Pro and is accessed through the Launch window. See Configuring 
FlexSmart Modules and Analog Sensor Ports on page 94 for details. 

Changing the default relay setting or testing the relay 

The default relay setting for the HOBO U30 Station is normally open, and can only be changed in 
HOBOware Pro. You can also use HOBOware Pro to test the relay.  

See Controlling the Relay on the U30 Station on page 27 for details.  
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Use HOBOlink to set up individual alarms. 

Testing individual Smart Sensors 

Use HOBOware Pro to test the accuracy of individual Smart Sensors.  

When the HOBO U30 Station is not logging,  

1. Unplug all Smart Sensors.  

2. Plug one Smart Sensor back in.  

3. Check the current reading for the sensor in the HOBOware Pro launch window.  

4. Repeat with the remaining Smart Sensors. 

Additional plotting and analysis of datafiles 

HOBOlink displays data read-out from the HOBO U30 Station in line graphs and shows the readings from 
the last connection. The data is also saved in a datafile that can be downloaded and saved to your 
computer. You can then open the datafile in HOBOware Pro and view and plot the data in different ways. 
See Working with Data for details. 
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Cont ro l l i ng  the  Re lay  on  the  HOBO U30  
S ta t ion  
The HOBO U30 Station has a built-in, system-wide relay. The default setting is deactivated (open). 

Steps 

To change the relay:  

1. Connect the HOBO U30 Station to the computer with the USB cable.  

2. From the Device menu, select Control Relay.  

3. Select Set default (deactivated) state.  

4. Select either Open or Closed.  

Testing the Relay 

To conduct an immediate test of the relay:  

1. Connect the HOBO U30 Station to the computer with the USB cable.  

2. From the Device menu, select Control Relay.  

3. Select Activate (close) relay.  

You should hear a click in the HOBO U30 Station.  

4. Select Deactivate (open) relay.  

You should hear the click again.  

Use HOBOlink to configure alarms for individual sensors, low battery, and low memory.  
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WORKING WITH  DATA  FILES  

P lo t  Da ta  

Viewing a Plot  

The plot displays sensor, state, and event information in three panes: 

• Details pane 

Information and statistics about the launch. 

• Points table pane 

Logger data presented in a tabular format. 

• Graph 

A graph of the sensor readings and events. 

Plot Data 

Four kinds of data can be displayed on the plot: 

• Sensor measurements 

• States 

• External events 

• Internal logger events 

Sensor Measurements 

Sensor measurements include the channels you selected to log at an interval during the launch, such as 
temperature, RH, or battery voltage. This type of data series consists of all the logged data points for that 
channel. In addition, if the logger recorded both temperature and RH, a dew point series can be plotted. 

States 

States are condition changes that can be recorded at any time during deployment, regardless of the 
logging interval (if any). Only state loggers, such as the U9 and U11, can record state changes. 

External Events 

External events are momentary switch closures (e.g., from turnstiles) that are recorded by loggers with 
external event channels, such as the U11 logger. 

Internal Logger Eevents 

Internal logger events are individually-logged occurrences that can be recorded at any time during 
deployment, regardless of the logging interval. U-Series loggers (other than the HOBO U30 Station) record 
internal logger events.  
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Examples of internal logger events include: 

• End of File: Marks the last record that was found in the logger. 

• Bad Battery: Time the battery capacity fell to an extremely low level (if applicable). If you see a 
Bad Battery event, replace the battery before deploying the logger again. 

• Stopped: Time the logger was manually stopped with HOBOware. 

• Host Connected: Time the logger was connected to the computer. 

• Coupler Connected/Coupler Disconnected: Time the logger was connected or disconnected from 
the coupler, if the logger uses a coupler to communicate with the computer. 

• Button Down/Button Up: For U-Series loggers that have event buttons, each button push of at 
least one second is logged as a Button Down event and a Button Up event. 

• Interval Change: For loggers that support multiple logging intervals, an Interval Change event 
marks the moment when a new logging interval began. 
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Open ing  Data  F i l es  
Only files with extensions of .hobo (including files created with Onset's GreenLine software and both 
Macintosh and Windows -compatible versions of HOBOware Lite and HOBOware Pro), .hsec, .hproj, .dtf 
(including files created with Onset's BoxCar Pro software), or .dsec can be opened directly by HOBOware 
Pro.  

Files with an extension of .dtf must come from a HOBO U30 Station, Weather Station, Micro Station, or 
Energy Logger Pro. Other .dtf files are not compatible with HOBOware Pro.  

Steps 

To open a file from: 

• The desktop 

Double-click a compatible file. HOBOware Pro automatically launches itself (if it is not open 
already) and opens the file.  

• HOBOware 

Click the Open icon  on the toolbar, or choose Open Datafile from the File menu. Select a 
compatible file and click Open.  

If verification fails, see Verification Failure. 

Complete the Plot Setup dialog to select the items you wish to view in the plot. Then click the Plot button. 
The plot is displayed. 

Tip: If you never use data assistants or change time zones, and would like to bypass the Plot Setup dialog 
every time you open a datafile, go to Preferences > General > Open File Time-Saving Options and 
select When opening a datafile: Automatically plot. This displays the plot with default Plot Setup 
selections. 

Project Files 

To open a project file, choose Open Project from the File menu. Then select a project (.hproj) file and 
click Open. 

Click the File menu and select a recently opened datafile or project file from the Recent Files list. 



- 31 - 

Impor t ing  Tex t  F i l es  
You may graph non-HOBOware data by importing data from certain text files:  

• You can easily open text files that were created by Onset’s Alarm & Readout Tool version 2.0 or 
higher.  

• You can also open text files that were exported from Onset's BoxCar Pro 4.3 software, using the 
default BoxCar export settings. This allows you to view data from Onset loggers that are not 
supported by HOBOware Pro. 

• With some adjustments, you can open text files that were exported from other software. You can 
also build text files from scratch, using historical or other types of information.  

Also see Importing Text File Requirements on page 33. 

Steps 

To import data from a properly formatted text file: 

1. From the File menu, choose Import Text Data.  

2. Select a text file (.txt) and click Open.  

3. If the text file was created by the Alarm & Readout Tool, skip ahead to step 8.  

Otherwise, HOBOware Pro attempts to parse the text file and displays the Text Import Information 
dialog. To conserve system resources, it displays only the first several records in the file, not the 
entire contents. 

4. Look at the data in the Delimiter Preview area to be sure that the date, time, and data columns 
were separated correctly.  

• If they were not, use the Data Separator, Date/Time Separator, and Decimal Separator 
pulldowns to choose other delimiters until the data looks correct. 

• You can resize the columns by clicking and dragging the dividers between the column headers.  

• For text files that were not exported in BoxCar's default format, click the Edit Date/Time 
Format button and ensure that the import function is interpreting incoming date, time, and 
year formats and separators correctly. Use the current date and time displayed in the Sample 
panel as a guide. Make changes as needed, then click OK. 

5. When the Delimiter Preview is correct, click OK.  

6. Depending on the file's contents, the Plot Setup dialog may be displayed at this time. If so, skip 
ahead to step 8.  

Otherwise, the Text File Information dialog is displayed. This dialog allows you to add optional 
information and change units, if needed.  

• Enter a Description, which will become the plot title and be included in the Details pane. 

• Select a Model from the list. If you select Other/3rd Party, you can enter a description (up 
to 20 characters) of the logger or other data source in the next field. 

• Enter the logger's Serial Number, if applicable. 

• In the Channel Parameters box, verify that the units are correct for the data in the file. 

7. Click OK.  

8. The Plot Setup dialog is displayed. Select the series you wish to view in the plot. You also have the 
option of changing the times on the plot to a different time zone.  
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9. When you have made your selections, click the Plot button.  

The plot is displayed. You may want to save your work in a project (.hproj) file for quick viewing later. 
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Impor t  Tex t  F i l es  Requ i rements  
When you import a text file, the file must meet certain requirements. You can view or edit text files in a 
text editor or word processor. To delete, rearrange, or reformat columns of data, you may need to use a 
spreadsheet program. Remember to save the corrected file in text (.txt) format. 

Serial Number 

There may be an optional header for serial number information located at the beginning of the file, before 
the column headings. At the beginning of the line must be the phrase "Serial Number:" followed by a 
space, then the serial number, then two dashes: 

Serial Number: 733329 -- 

Contents 

Below the header (if any) should be the data, starting with column headings. There must be no other text 
in the file other than the optional header, column headings, and data. The first column must be date, the 
next must be time, and the rest must be data. 

Delimiters 

Valid delimiters for separating date and time are space, comma, tab, and semicolon. Valid delimiters for 
separating other data are comma, tab, and semicolon. The delimiter used to separate the date from the 
time may be different from the delimiter used to separate the data.  

Date 

The date column must have the heading, "Date" and date values should be formatted as mm/dd/yy. If 
they are in a different format, remember to indicate the correct format in the Edit Date/Time Format 
dialog when you import the file. 

Date 
12/31/04 
12/31/04 
01/01/05 
01/01/05 

Time 

The time column must have the heading, "Time" and time values should be formatted in 24-hour format 
as hh:mm:ss.sss (decimals are optional). If they are in a different format, remember to indicate the 
correct format in the Edit Date/Time Format dialog when you import the file. UTC offset is assumed to be 
the same as your computer's current time zone. 

Time 
23:59:59 
23:59:59.5 
00:00:00 
00:00:00.5 

• No thousands separator can be used. 

• Rows of data must be separated with a paragraph return. 
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Measurements 

Data column headings must have the format "Measurement (Units)". Additional information (such as 
channel number or serial number) can follow, but is optional. Only spaces can be used between the end of 
the measurement name and the opening parenthesis. An example is "RH (%)".   

RH (%) 
38.7 
38.9 
39.0 
39.0 

If the column header and units of an imported series exactly matches the text in the table below, 
HOBOware will recognize the measurement and be able to perform unit conversions, apply data 
assistants, etc. to that series.  

Measurements listed below that either have only one unit type, or support any unit type, cannot have 
their units converted, but may still be used with applicable data assistants.  

Measurements that are not listed in the table (or do not exactly match the text below) are also supported, 
but without any units conversions or data assistants. 

Measurement Type  Column Header  Units 

Acceleration x accel, y accel, z accel g, m/s2, ft/s2 

Carbon Dioxide co2 ppm 

Counts counts [any units] 

Dew Point dew point F, C 

Leaf Wetness leaf wetness [any units] 

Light Intensity intensity lux, lum/ft2 

PAR par [any units] 

Pressure pres kPa, Pa, mbar, mm Hg, psi, in Hg 

Rain rain mm, in 

Relative Humidity rh % 

Soil Moisture soil moisture [any units] 

Solar Radiation solar rad W/m2 
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Sum Vector sum vector g, m/s2, ft/s2 

Temperature temp F, C 

Tilt x tilt, y tilt, z tilt deg, rad 

Wind Speed wind speed m/s, km/hr, mph, knots 

Gust Speed gust speed m/s, km/hr, mph, knots 

Wind Direction wind direction [any units] 
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Restor ing  a  Cor rupt  Header  
Occasionally, when trying to launch, check status, or read out a U-Series logger (other than a HOBO U30 
Station), HOBO Waterproof Shuttle, or HOBO U Shuttle, you may receive a "Read Header Failed" message. 

"Read Header Failed" messages occur when a device's header cannot be read, usually because of a 
communication error or corrupted header. Disconnect the device from the computer, then reconnect it and 
try to launch, check status, or read out again.  

If you receive the message again, the header has probably become corrupted. The most common cause of 
header corruption is a communication problem during launch, such as the USB cable coming loose or an 
optical logger slipping out of its base station/coupler while the Launching Logger progress bar is displayed. 
In that case, there is a possibility that valid data has been logged, but cannot be read out. 

You can restore the header by launching the logger or . This will reset the device's launch options to 
factory defaults. However, it will also cause any logged data (or offloaded data on a shuttle) to be lost. If 
you receive a "Read Header Failed" message and are unable to read out the logger or offload the shuttle, 
please contact the vendor that sold you the device. It may be possible to retrieve the logged data. 
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The  Po in ts  Tab le  
The Points table lists logger data in a table. The Points table is linked to the graph: only the data for the 
sensor measurements, states, and events displayed on the graph are listed in the Points table.  

The data points are listed chronologically. All the measurements, state changes, and events recorded by 
the logger at a given time are listed in a single row. Each series is displayed in a column. You can resize 
the columns by clicking and dragging the dividers between the column headers. 

 If you do not want plots to open with the sensor location shown in the Points and Details panes, disable 
the "Include sensor Location (if available) in points table and details pane" setting under Points Table & 
Details Pane on the Plotting Preference pane. 

Use the arrow keys or scroll bars to move up, down, left, and right in the Points table. Additionally, as you 
click the crosshair tool  in the graph, the corresponding point is selected in the Points table; if you click a 
value or event cell in the Points table, the crosshair will appear on the graph at the time corresponding to 
that cell.  

To print the points, go to the File menu and choose Print Points (available only with Java 1.5 or higher). 
To copy points, use the mouse to select the cells you want to copy, then press Ctrl+Command-C to copy 
them to the clipboard. 

Tip: You can export the data points to a text file for use in Microsoft® Excel® or other programs.  

To resize the pane, drag the divider between the Points table and the graph. 

You can hide the Points table. From the View menu, choose Points Table. Choose Points Table  again to 
redisplay the Points pane.  

If you do not want the Points table to be displayed by default when you view data, go to Preferences. On 
the Plotting pane, in Layout, disable the "Show the points table when plotting data" option. 
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Sav ing  F i l es  
HOBOware Pro allows you to save data in datafiles and project files:  

• A datafile (.hobo, .hsec, .dtf, or .dsec) is an unmodified record of the data that was in the logger 
when you read it out. You can use data assistants and change the appearance of the plot, but if you 
want to save those changes, you must save a project file. The original datafile remains intact. 

• A project file (.hproj) is a plot that has been customized by zooming, panning, adding or deleting 
series, placing the crosshair, using data assistants, changing series and axis properties, etc. When 
you open a project file, the plot appears as it did when you saved the project file, and contains all of 
the same data. However, there is no Plot Setup dialog for project files, and therefore you cannot use 
data assistants to create new series when opening a project file. 

Although you can save a project file without saving the original datafile, we strongly recommend saving 
datafiles so that you will always have access to the original data that was read out from the logger.  

  

Saving a datafile 

After reading out a logger, HOBOware Pro automatically asks if you want to save the datafile. Onset 
strongly recommends that you save the datafile at this time.  

If you decline, the plot is displayed with a name like "Untitled 1*" on the tab. The asterisk signifies that 
the data has not been saved. To save the logger data as a datafile: 

1. From the File menu, choose Save Datafile. 

2. Select a location for the file, if necessary, and enter a name for the file. 

3. Click the Save button. 

You can only save the data to a datafile once. 

Saving a .hproj project file  

Changes that you make to the appearance or content of the plot are not retained when you save the 
datafile. For example, if you have pasted series from another plot, created new axes and zoomed in, those 
changes will be lost unless you save them in a project file. 

To save your current data with a customized view of the plot, click the Save icon  on the toolbar, or 
choose Save Project from the File menu. To open an existing project file, choose Open Project from the 
File menu. 
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Expor t ing  Deta i l s  

Overview 

You can export the information in the Details pane to a text file, which can be opened in any text editor, 
or imported into many other types of programs (word processors, spreadsheets, etc.). 

To configure HOBOware Pro to automatically export the data to a text file every time the logger is read 
out, see Export Settings. 

 Steps 

To export details: 

1. Make sure the Details pane includes the series you want to export. This might include series pasted 
from other datafiles, or series derived through filters or data assistants. 

2. From the File menu, select Export Details. 

3. Accept the default file name, or type a new name and click Save. 
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Expor t ing  Po in ts  

Overview 

You can export the points shown in the Points table to a text file (.csv or .txt) for importing into Microsoft 
Excel and other applications.  

Before You Begin 

 To change the year format and time format, column separators, or include serial numbers in the export 
file, go to Preferences.  

Year and date format controls are located on the Display pane. Column separators (delimiters) and serial 
number export options are located under the Export Settings group on the General pane.  

Steps 

To export points: 

1. Make sure the Points table includes the series you want to export. This might include series pasted 
from other datafiles, or series derived through filters or data assistants. 

2. Click the Export icon  on the toolbar, or choose Export as Excel Text from the File menu.  

The Export Options dialog displays. 

3. To export all of the data in a single file, choose Export to a single file and click Export. In the 
Save dialog, accept the default location and file name, or enter a new location and name and click 
Save. 

4. To split the data over multiple files (particularly important if your data cannot fit in a single 
spreadsheet), choose Export to multiple files and make your selections: 

• Indicate the maximum Number of rows per file. Consult the documentation that came with 
your spreadsheet program to find out the maximum number of rows it accepts, and remember 
to leave room for header rows. 

• Accept the default Export Location, or click Choose to use a different location. (The default 
location creates a new folder for the files.) 

• Accept the default Filename Prefix (based on the datafile name), or enter a new one. The 
export file names will consist of this text plus "_PageX," where X indicates the order of the 
files (starting with 0). 

• Click Export. 

You can now open the file(s) in Excel or another package. You can easily view the raw data in a text 
editor.  

Formatting the date/time column in Excel 
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Format t ing  the  da te/ t ime  co lumn in  
Exce l  
In Excel, dates and times for each data point may initially appear as #######. Times also may not have 
seconds listed.  

Steps 

To display the full date and time with seconds in Excel: 

1. Adjust the time column so you can see the whole date and time.  

2. Select the time column from row 3 down. 

3. From the Format menu, click Cells. 

4. Select the Custom category and then select m/d/yyyy h:mm as the type. 

5. Add ":ss" (or ":ss.000" if you used a fast logging interval) to the end of the string in the Type field: 

m/d/yyyy h:mm:ss (normal logging interval) 
m/d/yyyy h:mm:ss.000 (fast logging interval) 

6. Click OK. The seconds should be listed automatically. 

To export the date and time in separate columns go to Preferences> General > Export Settings and 
enable the Date and time format: Separate into two columns.  
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Copy ing  Data  
To copy data from the Points table:   

1. Select the data with the mouse. 

2.  press Ctrl+C to copy it.  

3. Open any text editor, word processor, or spreadsheet software and press Ctrl+V to paste it in.  

Fields are delimited by tabs, and records are separated by paragraph returns. 

You can also copy the graph as a bitmap for pasting into other programs and documents. The graph must 
be visible when you do this.  

With the graph visible, select Copy Graph to Clipboard from the Edit menu. 
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C los ing  a  P lo t  

To close a plot, click the Close icon  on the toolbar, or choose Close from the File menu. If you are in 
tabbed view, you can also click the Close icon on the tab of the plot. If you are not using the tabbed view, 
you can click the Close box in the upper-right corner of the internal frame containing the plot.  

If you attempt to close a plot showing data that has not been saved as a datafile, a message appears 
asking if you wish to save the data in a file. Unless you are sure you do not need the data, it is strongly 
recommended that you save the file. 

To close all plots, choose Close All from the File menu. 

NOTE: If you are sure that you do not want HOBOware Pro to prompt you to save a plot as a datafile 
when you close it: go to Preferences > Warnings > General and clear the checkmark next to "Prompt me 
if there is any remaining unsaved data when closing plot or application." 
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Work ing  in  Secure  Mode   
(21  CFR  Par t  11  Con formance)  

Overview 

You can use your loggers and HOBOware Pro in Secure mode as components of a 21 CFR Part 11 system, 
or if you wish to add a level of security when working with datafiles. In Secure mode, HOBOware Pro 
begins an audit trail in the logger when you launch it, and adds an encoded digital signature to the new 
datafile when you read it out.  

A digitally signed file, or "secure file," has a filename extension of .hsec (for most U-Series loggers) or 
.dsec (for station-type loggers) and can be opened with HOBOware Pro 2.3.0 or greater. You can also 
open .hsec files with HOBOware Lite 2.3.0 or greater.  

The encoded digital signature provides the means to detect whether the file has been corrupted or 
tampered with. If even one bit of the data has changed since readout, a warning message will appear 
when you open the file, and none of the series will be marked as verified. 

Guidelines  

• The only way to create secure files is to read out a logger in HOBOware Pro while Secure mode is 
enabled. 

• Series that were created as a result of user input after readout, such as running a data assistant or 
entering a constant temperature value for pressure or humidity, are not verified. 

• Series that were created by filtering are not verified. 

• Series retain their verification status (and padlock icon) when copied and pasted into other plots. 

• Project (.hproj) and export files are not secure, even if you create them from secure files.  

• Issues may arise if you do not always use HOBOware Pro in the same mode, if you sometimes use 
HOBOware Lite, or if you sometimes use a version of HOBOware prior to 2.3.0.  

Enabling Secure Mode 

To enable Secure mode: 

1. Go to Preferences > General. 

2. Select Enable Secure Mode.  

When Secure mode is enabled, a padlock icon  appears in the lower right corner of the main HOBOware 
Pro window. 

Every time you open a secure file – even when you are not in Secure mode – HOBOware Pro or HOBOware 
Lite verifies the digital signature to ensure that the data in the file exactly matches what was read out 
from the logger. The padlock icon  appears in the legend next to the series that were verified as original 
data.  
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Audit Trail Information 

In the Details pane, audit trail information is displayed under the Data Verification node for each series. 
HOBOware Pro automatically obtains the Launch User and Readout User names from your computer's 
operating system. To save the Launch User name, you must have Secure mode enabled when you 
launch the logger. 

Verification Failure  

If, when opening a .dsec or .hsec file, HOBOware cannot verify the digital signature, it will display a 
message that verification has failed. This means that the file has been altered or become corrupted since 
it was originally saved. It will offer to display the plot if possible, but will not display the padlock icon in 
the legend or provide signing details in the Details pane. You will still be able to apply data assistants and 
filters, copy and paste series, export the data, save a project file, and perform other typical HOBOware 
Pro functions. 
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Secur i ty  Mode  Issues  
Issues may arise if you do not always use HOBOware Pro in Secure mode, if you sometimes use 
HOBOware Lite, or if you sometimes use a version of HOBOware prior to 2.3.0.  

Depending on the type of logger, the version of HOBOware that launched the logger, and the version of 
HOBOware that reads out the logger, the resulting datafile may not be compatible with versions of 
HOBOware prior to 2.3.0, or you may not be able to read out the logger at all. 

• Launch non-Secure (any version of HOBOware) 
Readout non-Secure (any version of HOBOware) 
A backward-compatible datafile (.hobo or .dtf) is created. 

• Launch non-Secure (any version of HOBOware) 
Readout in Secure mode 
A secure file (.hsec or .dsec) is created with an audit trail that lists the readout user, but not the 
launch user. Secure files are not backward-compatible. 

• Launch in Secure mode;  
Readout in pre-2.3 version of HOBOware 
Most U-Series loggers: The logger cannot be read out. 
Station-type loggers: A backward-compatible datafile (.dtf) is created. 

• Launch in Secure mode;  
Readout non-Secure in HOBOware 2.3 
Most U-Series loggers: A datafile (.hobo) is created, but it is not backward-compatible. 
Station-type loggers: A backward-compatible datafile (.dtf) is created. 

• Launch in Secure mode;  
Readout in Secure mode 
A secure file (.hsec or .dsec) is created with a full audit trail. Secure files are not backward-
compatible.  
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Data  Ass i s tan ts  

Overview 

HOBOware Pro Data Assistants let you create new data series by combining data recorded by the logger 
with additional data that you enter before you display the plot. For example, the kWh Assistant converts 
logged pulse data from an energy transducer to kWh, average kW, and energy cost. Some data assistants 
are included with HOBOware Pro, and others can be purchased separately. 

Using an Assistant 

When you read out a logger or open a datafile, all available assistants are listed in the Data Assistants 
section at the bottom of the Plot Setup dialog.  

To use an assistant, click its name to select it, then click Process to proceed. 

More Information 

For details on using an assistant see the assistant's help files (accessed by the Help button on the 
assistant's dialog) or user guide (located on the CD or web page where you downloaded the assistant). 

For an overview of each assistant, select the assistant and click the What's This? button.  

Hiding Assistants 

To prevent unwanted assistants from appearing in the Plot Setup dialog, or to bring back assistants that 
you have previously hidden, click the Manage button. This will open the Preferences dialog to allow you to 
change these settings. 

Installing an Assistant 

To install an assistant, click the Load button. In the resulting file dialog, locate the assistant's .jar file and 
click Open. If the new assistant is compatible with the series in this datafile, it will be added to the list of 
available assistants as soon as it is installed. If it is not compatible with the series in this datafile, it will 
still be loaded into HOBOware Pro, but will not be visible until you open a datafile with a compatible series.  
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L inear  Sca l ing  
This feature is supported only on U12 loggers that have external channels that can log voltage or 4-20mA. 
If your logger supports scaling, you will see a Scaling button on the Launch window for your logger.  

Linear scaling allows you to convert recorded logger data to some other measurement by entering new 
values that correspond with the logged values.  

The conversion must be based on a linear relationship. If the relationship is based on a curve, linear 
scaling will not give accurate results.  

For information about linear scaling of FlexSmart modules or Analog Sensor Ports, see Configuring 
Modules/Ports on page 94.  
 
For information about the Linear Scaling Data Assistant, refer to the Linear Scaling Data Assistant User's 
Guide. 

Steps 

Select an external channel to activate the Scaling button.  

To set up scaling for an external channel: 

1. Attach the logger and access the Launch window. 

2. Select the external channel(s) and choose the applicable input cable(s) from the drop-down list. A 

small icon  appears next to the input cable name to indicate that linear scaling is available. 

3. Click the Scaling button. The Scaling dialog will appear. 

4. Click a channel name in the Channel list, then click the Scale Channel box to activate scaling for 
that channel. 

5. Enter a descriptive name for the new, scaled channel in the Scaled Channel Name field. 

6. In the Scaled column of the Parameters box, enter the units name for the scaled series, and enter 
the scaled values in the Scaled column to correspond with the numbers in the Raw column. These 
values are used to establish a linear relationship between raw and scaled values. 
 
The default values in the Raw column are based on the high and low values supported by the input 
cable, but you may use different values, as long as those values fall within the cable's range.  

7. To set up linear scaling for another channel, repeat from step 4. 

8. Click OK to return to the Launch window and proceed as usual. The small icon  next to the input 
cable name will now be colored green to indicate that linear scaling has been set up. 

9. When you read out the logger, the new, scaled series will be listed in the Plot Setup dialog along 
with any other channels you logged. 
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WORKING WITH  A  GRAPH 

Work ing  w i th  a  Graph  
A graph is a visual representation of the series you selected to view when you opened the plot.  

Graph Components 

A graph includes: 

X axes 

Also called the time axes; displays the time ranges for the data. 

Y axes 

Also called the value axes; displays the values for all sensor series, such as temperature in degrees 
Fahrenheit or Celsius, or battery level in Volts. 

Title 

Title of the graph (default is the description entered at launch). 

Legend 

Displays the keys (colors or markers) for each sensor series, state, and event, as well as the units for 
each series.  

For .hsec and .dsec files, a padlock icon  appears in the legend next to the names of the series that 
were verified as original data.  
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Pas t ing  a  Ser ies  f rom Another  P lo t  
To combine data from multiple plots:  

1. Display the source plot (the plot which includes the series you want to copy) and the destination plot 
(the plot where you want to paste the series). 

2. On the source plot, choose the arrow tool  and select the series you want to copy. 

3. Right-click and choose Copy Series from the pop-up menu.  

Or, press Ctrl+C.  

4. With the arrow tool, right-click anywhere on the destination plot and choose Paste Series from the 
pop-up menu.  

Or, press Ctrl+V.  

 The new series is added to the graph, the Details pane, and the Points pane. 
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Over lay ing  Ser ies  
If the series you are comparing were logged at different times, you will need to make some adjustments 
to the plot in order to view the series together.  

1. Display the source plot(s) and the destination plot. 

2. On the destination plot, choose the arrow tool  

3. Double-click the time axis to access the Axis Properties dialog. 

4.  In the Axis Properties dialog, give the axis a unique Name 

5. Click Done. 

6. Copy a series from a source plot. 

7. Paste the series into the destination plot.  

When you paste the series, a new time axis will appear on the graph.  

8. Double-click the new time axis to access the Axis Properties dialog. 

9.  Give the axis a unique Name  

10. Click Done.  

11. Repeat steps 6-10 for each series you want to paste. 

12. Identify the periods of interest in each series you want to combine and note the times for each. 
Also, determine which period is the longest; this should be the length of time shown on each axis. 

13. Double-click a time axis and adjust its Min and Max bounds. The new bounds should include the 
period of interest for the series, and be the same length as the longest period identified in step 4. 
Repeat for each time axis. 

14. Use the hand tool  on each time axis to adjust the series horizontally as needed. 
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F i l t e r ing  a  Ser ies  
You can create a new series based on statistical analysis of an existing series over specified periods of 
time.  

Steps 

To use the filtering function: 

1. Choose the arrow tool  and select the series you want to filter. 

2. Right-click and choose Filter Series from the pop-up menu. 

3. Choose the type of statistic to use for the filter: 

• For sensor series, you can create a series showing the minimum, maximum, or average over a 
period of time. 

• For state series, you can create a series showing the percentage of time the state was high, 
percentage of time the state was low, number of seconds high, number of seconds low, total 
0-to-1 changes, or total 1-to-0 changes over a period of time. 

• For external event series, you can create a series showing a cumulative sum, or a count over a 
period of time. 

• For internal event series, you can create a series showing a count over a period of time. 

• For series created by data assistants, additional filters may be available. 

4. Specify the interval over which you want these values to be calculated.  

5. Enter a new Resultant Series Name, if desired. 

6. Click OK. The new series is added to the graph, the Details pane, and the Points pane. 

NOTE: When you apply a filter, the graph rescales to accommodate all of the displayed data. 
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Remov ing  a  Ser ies  f rom a  P lo t  
You can remove sensor, state, and event data series from the plot. This is helpful if the datafile contains 
multiple series and you cannot easily view them all together. 

Steps 

To remove a series from a plot: 

1. Select the arrow tool  from the toolbar. 

2. Click the series you wish to remove and press the Delete key, or right-click the series and choose 
Remove from the menu that appears. 
 

A warning appears, indicating that the only way to add the series back to the plot is to reopen the plot.  

3. Click Yes. 

 The series is removed from the graph, the Details pane, and the Points table. 
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Labe l ing  a  Graph  
You can add labels to a graph to identify specific points or call attention to a region of the graph. 

Steps 

To add a label to the graph: 

1. Right-click the graph and choose Add Graph Label from the pop-up menu; or, choose Add Graph 
Label from the Edit menu. The Label Properties dialog appears. 

2. In the Label Properties dialog, enter a name for the label. 

3. Set other properties and click Done. 

Important: The Locationindicates the preferred location of the label (space permitting) with respect to 
the data point it references. This is available only when the label is attached to a series. 

4. Use the hand tool  to drag the label to the desired location. If the label is attached to a series, you 
can drag the label to attach it to any other point on the graph. (The hand tool must be close enough 
to a point to attach the label.) 

Labels that are attached to a point will move with that point during zooming and panning. Free-floating 
labels do not move during zooming and panning.   

To delete a label from the graph, select the label you wish to remove and press the Delete key. Or, right-
click the label and choose Remove from the menu that appears. 
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Us ing  the  C rossha i r  Too l  
Use the crosshair tool to zero in on a specific date and time in the plot and any data points associated with 
that date and time. 

1. Select the crosshair tool: 

Click the Crosshair icon  on the toolbar, or press the C key on your keyboard 

2. Click a point on the graph to mark it.  

3. Click another point to move the marker.  

NOTE: When you click on a graph, HOBOware Pro selects the nearest data point. When series are very 
close together, and the location you click is between two points, it is possible that the nearest point is not 
on the series you clicked.  

You can also mark the point on the graph by clicking the corresponding cell in the Points table.  

Scrolling 

Normally, if you are zoomed in and click a point in the Points table that is outside the zoom area,  
HOBOware will scroll to the marked point's area of the graph. If you do not want HOBOware to scroll, 
change the setting under Points Table & Details Pane on the Plotting preference pane. 

Changes to Plot 

The plot changes in several ways when the crosshair is in use. The Points pane shifts to the row that 
contains the data point. Where the crosshair intersects a data point, a square surrounds the data point. 
The intersection points are also marked by small color-coded arrows on the left and right value axes.  

Legend 

If the legend is displayed next to the graph, the point values for each series are updated to reflect the 
crosshair location. Values are listed in the legend differently depending on whether the data is a logged 
sample, state, or event: 

• Values that are not in parentheses are actual data points logged at the time selected by the 
crosshair. 

• Values in parentheses are estimated because there were no exact values for the series at the time 
selected by the crosshair. Zoom in or move the crosshair to see actual values. 

• A value of "…" indicates that there is no series data during the time selected. This is seen most 
frequently for events. If the time selection falls within an event series, but does not contain an 
event, parentheses surround the "…" value. 

• A value of "logged" indicates an internal logger event happened at the selected time. 

NOTE: The legend must expand in height to list the point values. If your application window is too small 
to accommodate the expanded height, the values will not be added to the legend. You can still refer to the 
Points table to find the values of the selected points. 

Removing the Crosshair 

To remove the crosshair from the graph, right-click on the graph and select Remove Crosshair from the 
pop-up menu. Or, choose Remove Crosshair from the View menu. 
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The  Subse t  S ta t i s t i c s  Too l  

Description 

Use the Subset Statistics Tool to view statistics for a particular time span.  

Using the Tool 

1. Select the tool: 

• Click the Subset Statistics icon  on the toolbar; or 

• Press the S key on your keyboard when the mouse pointer is on the graph 

2. Click within the graph to define the start time of the subset.  

3. Hold down the left mouse button and drag to the right. Release the mouse button when you reach 
the end time of the subset.  

Two labeled vertical indicators appear on the graph to show the bounds of the subset, and a labeled 
horizontal indicator shows the duration of the subset. Additionally, a Subset Statistics pane appears at the 
bottom of the Details pane, summarizing the data within the subset. 

There is also a shaded bar on the time axis. You can use this bar and/or the arrow keys to quickly move or 
change the subset. 

Actions 

Toggle the Display 

To toggle the display of subset indicators and labels, double-click the shaded subset statistics bar. 

Adjust Height 

To adjust the height of the horizontal indicator and duration text, use the up and down arrow keys . 

Adjust the Start or End of the Subset 

Tto adjust the start or end of the subset, click and drag the left or right end of the subset statistics bar. 
You can use the arrow keys to move the left boundary, and Ctrl+arrow keys to move the right boundary. 

Click inside the subset statistics bar and drag it horizontally to move the subset without changing its 
duration. 

Change Time Axis 

If you have multiple time axes, click inside the subset statistics bar to drag it to a different time axis. 

When you first draw the subset, it is attached to the oldest time axis on the graph (the time axis that was 
created when you displayed the plot). 

Move or Change the Subset 

You can move or change the subset using the Subset Statistics tab in Axis Properties. To quickly access 
this tab, click the checkmark icon in the Subset Statistics pane.  
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Removing the Pane 

To remove the subset statistics pane, indicators, and subset statistics bar:  

• Right-click on the graph and select Remove Subset Stats from the pop-up menu, or  

• Choose Remove Subset Stats from the View menu, or 

• Click the X icon in the upper-right corner of the Subset Statistics pane. 
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The  Hand  Too l  

Overview 

Use the hand tool to move different areas of the graph into view or adjust the position of one series so it 
can be viewed more easily. This is particularly useful when you are zoomed into the graph and want to see 
another section of the graph without zooming out and then zooming back in on the new location. 

NOTE: Panning will not work on an axis that is locked. To unlock an axis, double-click the axis with the 
arrow tool and clear the checkmark next to Lock Axis Scaling and Tick Marks. 

Using the Hand Tool 

 There are two ways to select the hand tool:  

• Click the Hand icon  on the toolbar; or 

• Press the H key on your keyboard. 

  

Pan Across Graph 

Click within the graph and hold down the left mouse button to pan a different section of the graph into 
view. The graph follows the movement of the mouse, and the axes are continuously updated in response 
to the movement. To stop dragging, release the left mouse button. 

Restrict Motion 

Hold down the X key while dragging to restrict motion horizontally. Hold down the Y key while dragging to 
restrict motion vertically. 

Pan One Sseries at a time 

Click the axis associated with the series and hold down the left mouse button. Only the series connected 
with the axis will follow the movement of the mouse. 
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The  Zoom Too l  

Overview 

Use the zoom tool to focus on one area of the graph, allowing you to see more detail.  

NOTE: Zooming will not work on an axis that is locked. To unlock an axis, double-click the axis with the 
arrow tool and clear the checkmark next to Lock Axis Scaling and Tick Marks. 

Using the Zoom Tool 

To select the zoom tool: 

• Click the Zoom icon  on the toolbar; or 

• Press the Z key on your keyboard. 

Toggle 

Right-click to toggle between zoom in and zoom out.  

Zoom Direction 

Check the symbol inside the zoom tool to determine the direction you are zooming. A plus sign (+) or 
arrows pointing outward will zoom in, while a minus sign (-) or arrows pointing in will zoom out. 

Level 

Click an area on the graph inside the axes to zoom one level (a factor of two). Continue clicking to zoom 
multiple levels. 

 Zoom Continuously 

Hold down the left mouse button in one location to zoom continuously. Release the mouse button to stop 
zooming. 

Zoom in Area 

Hold down the left mouse button while drawing a rectangle around the area you wish to zoom in on, then 
click inside the rectangle. The area inside the rectangle expands to fill the whole graph. 

Restrict Motion 

Hold down the X key while zooming to restrict motion horizontally. Hold down the Y key while zooming to 
restrict motion vertically. 

Tip: If you are currently working with the crosshair, arrow, or hand tool, you can click the Zoom In/Out 

icons  and  on the toolbar to quickly zoom into and out of the middle of the display without 
changing tools. 
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Reset t ing  the  Sca le  
You can easily reset the scale to accommodate all of the displayed data. This is very helpful when you 
have zoomed or panned several times and want to quickly go back to the original scale. 

Click the Revert icon  on the toolbar, or choose View Full Scale from the View menu. The X and Y 
axes are rescaled to show the full duration and values of all displayed data. Any customizations to 
properties and crosshair location are retained when you return to the original graph, but this removes any 
adjustments to the view that you made by zooming or dragging with the hand tool. (If you deleted any 
series, they will not be included in the rescaling.) 
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Organ iz ing  P lo ts  
Use the Window menu to organize several plots.  

The following selections are available from this menu: 

• Tabbed View:  

Layers the plots as tabs so that you can see the file name of each open plot (or "Untitled*" for an 

unsaved datafile). You can also get to this view by clicking the Tabs icon  in the lower left of the 
HOBOware Pro window.  

• Tile Horizontally: 

Arranges up to five plots horizontally. If six or more plots are open, they will be tiled as a grid. You 

can also get to this view by clicking the Horizontal Tile icon  in the lower left of the HOBOware 
Prowindow.  

• Tile Vertically:  

Arranges up to five plots vertically. If six or more plots are open, they will be tiled as a grid. You 

can also get to this view by clicking the Vertical Tile icon  in the lower left of the HOBOware 
Prowindow.  

You can open the same datafile multiple times to create different views of the graph, then use the Tile 
commands on the Window menu (or resize and move the windows manually) to see all of them at once. 
This is helpful if you want to zoom in on several different areas and view them side-by-side, see the detail 
of a small area while the full graph is still in view, or view each series in a different window. 
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Customiz ing  a  P lo t  
Changing Unit System 

You can switch between US and SI (Metric) measurements while the plot is open.  

To change the units of an individual series, right-click the series with the arrow tool and choose Convert 
Series Units. Select the new unit type from the drop-down list. 

To change the units for multiple series, click the Units icon  on the toolbar. For each series, select the 
units from the drop-down list, then click Convert. 

This changes the units displayed on the axis, in the legend, in the Details pane, and in the Points table. 

Displaying Gridlines 

By default, vertical gridlines are always shown for the time axes; horizontal gridlines are not shown. You 

can use the gridline icons  and  on the toolbar, or a Gridlines item on the View menu, to toggle all 
horizontal or all vertical gridlines on and off.  

You may also toggle gridlines on and off for each axis individually. Using the arrow tool, double-click an 
axis to get the Axis Properties dialog. Check the Show Gridlines box to display gridlines for that axis, or 
clear the Show Gridlines box to hide the gridlines. 

Use the Gridlines options on the Plotting pane in Preferences to control whether plots open with 
horizontal and/or vertical gridlines displayed. 

Marking Points 

By default, points on a series are usually not marked. You can use the Mark All Points item on the View 

menu, or the Mark Points icon  on the toolbar, to toggle all point markers on and off.  

You may also toggle Mark Points on and off for each series individually. Using the arrow tool, right-click a 
series to get the context menu, then choose Mark Points. 

 To control whether plots open with all points marked by default, use the Mark all points when plotting 
data option on the Plotting pane in Preferences (under Other Options). 

Tip: Opening a large plot with all points marked takes longer and consumes more system memory. 

Smart Scaling 

When you first display a graph, the numerical bounds of the axes are on tick marks. After you have 
panned or zoomed, this may no longer be the case. Use smart scaling to adjust the axes to end on tick 
marks. With the hand, arrow, or crosshair tool, right-click anywhere on the graph and select SmartScale 
Graph. 
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Changing the Order of a Series 

You can shuffle the order of series by moving a series to the front or back. This is helpful if one series is 
hidden behind another. It also changes the order of series in the Details pane, Points table, and the 
legend.  

To change the order of the series: 

1. Select the arrow tool  from the toolbar. 

2. Select the series you wish to move. 

3. Right-click and select either Bring Series to Front or Send Series to Back. 

NOTE: After you adjust the order of the series for optimal viewing, copy the graph as a bitmap to paste 
into other programs, such as Microsoft Word or PowerPoint®.  

Changing Font Size in Plots 

By default, most text in a graph is 9 points. Use the Font Size for Plots option on the Plotting pane in 
Preferences to re-size the font (from 8 to 14 points). 

Hiding Sensor Locations  

By default, the location string for a station-type logger sensor is shown in the Points or Details panes. If 
you do not want to include the sensor locations, deselect Use sensor Location in the Plotting 
Preferences, as shown below. 

 



  

- 64 - 

Pr in t ing  Graphs ,  Po in ts ,  o r  De ta i l s  

Printing a Graph 

You can simply print the graph, or you can set up the page and preview it before printing. 

To set up the paper for printing the graph: 

1. From the File menu, choose Page Setup. 

2. Change the paper type, orientation, and margins as necessary and click OK. 

3. To preview how the graph will look on the page: from the File menu, choose Print Preview.  

4. Zoom as necessary 

5. Click the Print icon  to print directly from Print Preview. Or, click Close to exit the preview 
window without printing. 

To print the graph: 

1. Click the Print icon  on the toolbar, or choose Print from the File menu. 

2. Select the appropriate printer, if applicable, and click OK.  

Printing Points and Details 

You can print all of the data in the Points or Details panes. From the File menu, select Print Points 
(available only with Java 1.5 or higher) or Print Details. 

If you highlight a selection of points with your mouse before choosing Print Points, you will also be given 
the option to print only the selected points. 
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CUSTOMIZING GRAPH PROPERTIES  

Overv iew 
You can change aspects of the graph as you analyze the data. Use the arrow tool to select different 
components in the graph. 

Options 

There are many ways you can adjust and customize the graph:  

• Add series by pasting or filtering 

• Remove series 

• Add labels 

• Zero in on specific data points with the crosshair tool 

• View statistics for a particular time span 

• Zoom in and out  

• Pan a zoomed area of the plot 

• Reset the scale to accommodate all displayed events and series 

• Change axis, label, legend, series, title, or view properties 

• Use miscellaneous plot controls 

After you have adjusted and customized the graph, save your work in a project (.hproj) file. 

Important: Property changes are not saved when you close the datafile. To preserve these changes, you 
can paste a bitmap of the graph into other programs, or save changes to the plot in a .hproj project file. 

Subset Statistics 

To access properties for subset statistics, click the checkmark icon in the Subset Statistics pane, or 
double-click the time axis and choose the Subset Statistics tab. 

Using the Arrow Tool 

There are two ways to select the arrow tool: 

• Click the Arrow icon  on the toolbar; or 

• Press the A key on your keyboard 

Tip: If you are currently using another tool and do not want to switch tools, you can press the N (next) 
key on your keyboard to select each graph item (including hidden items, such as value axes for states or 
events) in sequence.  

The selected item (if visible) is shaded or boxed. You can then right-click the selected item, double-click it, 
or press the Enter key on your keyboard to open the Properties window for that item. 

To deselect, click an area within the axes that does not have series data; click the View menu and choose 
Select None; or press D on your keyboard. 
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Ax is  P roper t i es  D ia log  

 

There are two types of axes: time axes and value axes. The time axis is the x axis, which lists the dates 
and times for the datafile. The value axis is the y axis, which lists the range of values for the series (for 
example, the temperature axis displays degrees in Fahrenheit or Celsius). The graph can contain several 
value axes depending on the number of series displayed.  

To change the axis properties, double-click the axis you wish to modify with the arrow tool. Or, select the 

axis and click the Properties icon . 

There are two tabs in Axis properties for time axes. The General tab includes the options described 
below. Also see Subset Statistics Properties on page 68. 

The following options are available on the Axis Properties dialog: 

• Name: Enter up to a 40-character name for the axis. The default name for a value axis is the unit 
type (for example, "°F" is the name for a temperature axis and "%" is the name for an RH axis).  

Normally, the time axis is not named when you display a plot. If you want plots to open with the 
time axis labeled as "Time" by default, change the setting under Other Options on the Plotting 
pane in Preferences. 

• Location: Change the location of the axis. The time axis can be located at the top or bottom. The 
value axes can be located on the left or right. 

• Min: Enter the minimum value you want displayed for the axis. For the time axis, you can select a 
date and time. 

• Max: Enter the maximum value you want displayed for the axis. For the time axis, you can select a 
date and time. 

• Auto-calculate tick marks or custom tick marks: Tick marks are the lines that represent values 
on the axis. Numbers or values are listed next to major tick marks; minor tick marks are not 
numbered. By default, tick marks are automatically calculated for both the time and value axes. 
Choose the Custom Tick Marks option to specify different major and minor tick marks for the axis. 
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• Show Gridlines: Toggles whether gridlines are displayed in the background. By default, gridlines 
are shown for the time axis only. 

• Hide Axis: Toggles whether the axis is displayed or temporarily hidden. Axes for sensor series are 
visible by default. 

• Lock Axis Scaling and Tick Marks: Toggles whether the axis and associated tick marks remain in 
the original position when zooming or navigating with the hand tool. Locking the axis and tick marks 
helps to avoid inadvertently zooming or navigating to an area on the graph without data. 

• Color: Changes the color of the axis. Black is the default color for the time axis. The color of the 
value axis matches the series color by default. 
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Subset  S ta t i s t i c s  P roper t i es  
For time axes, there is an additional tab in Axis properties to create, change, or remove a statistics 
subset. 

To change the subset statistics properties, click the checkmark icon in the Subset Statistics pane, double-

click the time axis with the arrow tool, or select the axis and click the Properties icon . Then choose 
the Subset Statistics tab in Axis properties.  

The following options are available on the Subset Statistics Properties dialog: 

• Show subset statistics for time bounds below: Check this box to enable subset statistics for 
this time axis. 

Only one time axis can have a subset. If you enable subset statistics for one time axis when 
another time axis already has a subset, the other time axis's subset will be removed. 

• Show times, duration, & vertical indicators on graph: Check this box to toggle the display of 
subset indicators and labels on the graph. If you disable this option, the Subset Statistics pane and 
the shaded subset statistics bar on the time axis will still remain visible. 

• Start/End Date/Time: If both of the Anchor Start/End Point boxes are unchecked, you may 
enter the precise dates and times of the start and end of the subset. If one box is checked, you may 
enter a precise start or end date/time in conjunction with a precise duration. 

• Anchor Start/End Point: Check one of these boxes if you want to enter only a precise start or end 
date/time, in conjunction with a precise duration. 

• Duration: To enter a precise start or end date/time in conjunction with a precise duration, check 
the appropriate Anchor Start/End Point box, then enter the start or end date/time and duration. 
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Labe l  P roper t i es  D ia log  

 

To change a label's properties, double-click the label. Or, select the label and click the Properties icon . 

To add a label to the plot, right-click the graph and choose Add Graph Label from the pop-up menu. 

The following options are available on the Label Properties dialog: 

• Label Text: Enter up to a 24-character name for the label. 

• Attach to Series: To attach the label to a point on a series, check this box and choose the name of 
the series from the drop-down list. (After you exit this dialog, you can use the hand tool  to drag 
the label to the correct point.) 

• Include Data Value in Label: If the label is attached to a series, check this box to have the label 
show the value of the labeled point. 

• Location:If the label is attached to a series, choose a compass point to describe the preferred 
position of the label relative to the labeled point. 

• Draw Label Over Colored Background: Check this box if you want the label to appear in a box 
with a colored background. 

• Label Color Background: If you chose to give the label a colored background, click this button to 
select a background color. 

• Label Color Text: Click this button to select a color for the label text. 

• % Transparency: Adjust the label's transparency. Transparency refers to the ability to see the 
graph through the label. At 0%, the label is opaque, and you cannot see the graph through it. At 
100%, the label is invisible, and only the graph can be seen. 

• Font: Select a font for the label text.  

• Font Size: Select a font size for the label text. 
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Legend  Proper t i es  
The legend is the area that lists the keys for each series (line colors and marker types). If the crosshair is 
in use, it also lists the date, time and point values currently selected by the crosshair. 

Tip: To quickly hide or display the legend, click the View menu and select Show Legend. 

To change the legend properties, double-click the legend. Or, select the legend and click the Properties 

icon . 

The following options are available on the Legend Properties dialog: 

• Name: Enter up to a 40-character title for the legend. There is no default name. 

• Location: Move the legend to either the left or right side of the graph. By default, the legend 
appears on the right. 

• Show Border: Toggles whether a box is drawn around the legend. By default, a border is shown.  
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Ser ies  P roper t i es  D ia log  

 

The series is the group of data points for the sensor measurement, state, or event you selected to display 
in the plot. To change series properties, double-click the series you wish to modify. Or, select the series 

and click the Properties icon . 

The following options are available on the Series Properties dialog: 

• Description: Enter up to a 40-character name for the series. The series name is displayed in the 
legend. The default name for a series with sensor data is the property that was measured and the 
units used to display the measurements. The default name for a series with event or state data is 
the type of event or state.  

• Units: Enter the unit type in this field, if it is different from the default. If, while viewing the plot, 
you convert to another type of unit, the text you enter here will change to the default name for the 
unit you chose.  

• Connect Points: Toggles whether the points in this series are connected. This option is selected by 
default for most series; it is not selected for internal logger events.  

• Style: Changes the appearance of the line used to connect the points in a series. The default varies 
depending on how many series measuring the same property are being viewed. 

• Width: Changes the size or weight of the line used to connect the points in a series. The default is 1 
point. 

• Connect as Steps: Toggles whether the lines between the points in a series are connected as a 
curve or a step. When this option is selected, the line drawn between points keeps the value of the 
previous point until the next point in the series. This is useful for state or event graphs. This option 
is not selected by default for sensor series. 

• Mark Points: Toggles whether a marker appears at each data point in this series. By default, this 
option is selected for any series with event data or only one point; to avoid cluttering the graph, it is 
not selected by default for other series. 
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• Marker: Changes the shape of the marker used. The default marker varies depending on how many 
series are being viewed. 

• Point size: Changes the point size for the marker.  

• Enable Alarms: Available for sensor measurement series only; not available for state or event 
series. Toggles whether red and blue alarm lines are shown on the graph for this series. Use an 
alarm line when you want to indicate a visual threshold over or under which data may be falling (for 
example, if you want to quickly see how many points fall below 32 degrees). Alarm lines are turned 
off by default.  

o For High Alarm, enter a value relative to the series where you want the maximum (red) 
alarm line to appear. 

o For Low Alarm, enter a value relative to the series where you want the minimum (blue) 
alarm line to appear. 

• Time Axis: Allows you to create an additional time axis for this series. This is useful when you want 
to compare data from two different time periods. 

• Value Axis: Changes the axis being used for the series. Choose one of the axes already in view, or 
select New Value Axis from the dropdown list to create your own. 

• Color: Changes the color used for the series. The default color varies depending on how many 
series are displayed on the graph. 
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T i t l e  P roper t i es  
The title is the name of the graph. To change the title properties, double-click the title. Or, select the title 

and click the Properties icon . 

The following options are available on the Title Properties dialog: 

• Name: Enter up to a 40-character title for the graph. By default, the name is the description 
entered when launching the logger. 

• Location: Move the title to either the top or bottom of the graph. The default location is the top of 
the graph. 

• Font: Select a font type, size, and appearance. 

Tip: To quickly hide or display the title, click the View menu and select Show Title. 
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V iew Proper t i es  
The view controls the general aspects of the graph. To change the view properties, deselect all graph 
elements, then double-click the plot with the arrow tool. Or, click a blank area of the graph and click the 

Properties icon . 

The following options are available on the View Properties dialog: 

• Show Legend: Toggles whether the legend is displayed on the graph. The legend is shown by 
default. 

• Show Title: Toggles whether the title is displayed for the graph. The title is shown by default. 

• Show Border: Toggles whether a border is displayed around the graph. By default, a border is not 
shown. 



- 75 - 

CUSTOMIZING HOBOWARE  PREFERENCES  

Se t t ing  P re fe rences  
You can change the default behavior of HOBOware in the following categories.  

• General (page 82) 

• Communications (page 81) 

• Plotting (page 79) 

• Display (page 77) 

• Warnings (page 76) 

• Data Assistants (page 47) 

  

To change preferences, go to File > Preferences and then the category. 

Preference settings are unique for each user login on your computer.  

To quickly change some key preferences or to install new data assistants, use the Setup Assistant. 

 If you have installed add-on tools for HOBOware Pro, additional preferences may be available. Refer to 
the Help within the add-on tool for information about these preferences. 

Restoring Default Preferences 

To return all preferences to their original settings for a user login, in the Preferences pane click the 
Restore Defaults button. A warning appears, asking if you are sure you want to continue. Click Yes. The 
preference defaults are restored. 

In addition to the preferences on these panes, HOBOware retains the following: 

• Data File Folder Locations 

Each user account's preferred folder locations for datafiles (.hobo, .hsec, .dtf, and .dsec), text files 
(.csv or .txt), and project (.hproj) files. The three folder locations are tracked separately based on 
the folders you last accessed. When you restore the preference defaults, the default folder for each 
file type is reset to the HOBOware folder in your My Documents folder.  

• FlexSmart modules or Analog Sensor Ports 

Custom-defined channel names and units for FlexSmart modules or Analog Sensor Ports are stored 
as preferences. When you restore the preference defaults, the custom-defined channel names and 
units are removed from the pull-down menus in the Configure Channel dialog. However, this will 
not affect customized channel names and units that you saved in configuration files (.hcfg). 

• HOBOware software updates 

The date and time of the most recent check for HOBOware software updates. When you restore the 
preference defaults, HOBOware will not retain this date, and will offer to check for updates the next 
time you restart HOBOware. 
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Pre fe rences  -  Warn ings  
Some  HOBOware warning dialogs offer you a checkbox to disable the warning so that you do not see it 
again. You can manage (and re-enable) these warnings in the Warnings pane. 

Warnings are listed in three groups: general, pre-launch, and post-launch. To enable all of the warnings in 
a group, click the Select All button for that group.  

To disable all of the warnings in a group, click the Select None button for that group. Before you do so, 
however, keep in mind that the warnings are intended to help prevent mistakes and inadvertent data loss. 
Review each warning carefully before disabling it. 
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Disp lay  P re fe rences  
The following preferences are available on the Display pane: 

Default Units 

• Unit System. This setting allows you to set a default of US or SI (Metric) units throughout 
HOBOware Pro. It changes the units in the Current Readings the next time you display the Status 
window, and the default units in the axis, legend, points, and details the next time you display a 
plot. The default is US. 

Date/Time 

• Year Format. Controls whether HOBOware Pro displays the last two digits of the year, or all four 
digits. The default is 2-digit Year. Changing this setting will cause all open plots to be redrawn. 

• Time Format. Controls whether HOBOware Pro displays the time in a 12-hour or 24-hour format. 
The default is 12-Hour. Changing this setting will cause all open plots to be redrawn. 

When you create an export file, the date and time are exported as they appear in the Points table. If you 
open the file in Excel, they are automatically reformatted to Excel's default date and time format, which 
you may customize within Excel. 
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Data  Ass i s tan t  P re fe rences  
Data assistants are HOBOware Pro plug-ins that let you create new data series by combining data 
recorded by the logger with additional data that you enter before you display the plot.  

When you read out a logger or open a datafile, all compatible assistants are listed in the Plot Setup dialog. 

To learn more about an assistant, click the question mark icon next to the assistant's name. To prevent an 
assistant from being listed in the Plot Setup dialog, clear the box next to its name. To re-enable an 
assistant that you have previously disabled, check the box next to its name. 

To enable all of the data assistants, click Show All. To disable all of them, click Hide All. To install new 
assistants, click Setup Assistant at the bottom of the Preferences window, or click the Load button in 
the Plot Setup dialog when opening any datafile.  
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P lo t t ing  P re fe rences  
The following preferences are available on the Plotting pane: 

Fonts 

• Font Size for Plots  

Controls the size of most text on the graph. The default is 9 points, but you can also choose 8, 10, 
11, 12, or 14. The plot title will default to two points larger than the selected font size. 

Layout 

• Show the details pane when plotting data.  

By default, the Details pane is not open when you display a plot. If you want the Details pane to be 
hidden when you display a plot, clear this box. 

• Show the points table when plotting data.  

By default, the Points table is open when you display a plot. If you want the Points table to be 
hidden when you display a plot, clear this box. 

Points Table & Details Pane 

• Include sensor Location (if available) in points table and details pane. This setting adds the 
sensor's location string, if it has a location defined, to each column header in the Points table and to 
the Details pane. This is especially useful if you have data that includes similarly-named series that 
were recorded on different sensors; for example, a HOBO Micro Station datafile with data from three 
voltage sensors.  

• When selected value in table is out of plot range, drag series to that value. Normally, if you 
are zoomed in and click a point in the Points table that is outside the zoom area, HOBOware Pro will 
scroll the marked point into view while retaining your zoom factor. Clear this box if you do not want 
HOBOware Pro to scroll. 

Gridlines 

• Enable horizontal gridlines when plotting data.  

By default, horizontal gridlines are not displayed when you open a plot. Enable this option if you 
always want a new plot to display gridlines for all value axes. 

• Enable vertical gridlines when plotting data.  

By default, vertical gridlines are always displayed when you open a plot. Clear this checkbox if you 
never want a new plot to display gridlines for the time axis. 

Plot Setup 

• Automatically select all data series for plotting 

By default, when you read out a logger or open a datafile, some series (such as Dew Point) are not 
selected for display on the Plot Setup dialog. Enable this option if you want every series to be 
selected. 

• Automatically select internal events for plotting (e.g. Button Up/Down, Host Connected, 
EOF) 

When you open a plot, internal events are selected by default on the Plot Setup dialog. Clear this 
box if you usually do not want to see these events.  
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Other Options 

• Mark all points when plotting data 

By default, when you display a plot, point markers are displayed for any series with event data. 
Otherwise, to avoid cluttering the graph, point markers are not displayed. Enable this option if you 
want all points to be marked on every series whenever you display a plot. On a large plot, marking 
all points takes longer and consumes more system memory. 

Series that consist of only one point are always marked.  

• Label the time axis  

By default, the time axis is not labeled when you display a plot. If you enable this preference, the 
time axis will have a default name of "Time" when you open a plot. 

• When plotting multiple series of the same unit type:  

By default, if there are multiple series of the same unit type (for example, temperature and dew 
point series in degrees Fahrenheit), HOBOware Pro plots all of the series in the same color, and 
uses a different line style (solid, dashed, dotted, etc.) for each. Choose Use a different color for 
each series instead if you prefer each series to have a solid line in a different color. The series will 
still be attached to a single, common axis, but only one series will match the axis color. 
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Communica t ion  P re fe rences  
The following preferences are available on the Communications pane: 

Device Types 

• Select device type. If you use only USB loggers or only serial loggers, click the appropriate button 
for improved logger response time. Otherwise, if you use both types of loggers regularly, keep the 
default of USB and serial devices. You can quickly change this preference by using the pulldown 

next to the Select Device icon  on the toolbar. 

Serial Ports 

• Serial port(s) to use. Select the specific serial ports you want HOBOware Pro to search for 
devices, or click Select All to have HOBOware Pro check all of the serial ports shown on this list 
when it searches for devices. Note that if you want HOBOware Pro to use only one port (the default 
is COM1), you can have only one serial logger connected at a time. However, checking multiple 
ports can cause slow performance, even when no loggers are connected.  

Device Speeds 

• Serial port speed: Fast serial enabled allows the computer to read out your serial logger at a 
speed that is appropriate for most systems. Disable this option only if you are having 
communication problems with the logger; for example, when the logger is connected via a slow 
serial-to-LAN bridge device. Communication between the computer and the logger is slower when 
this option is turned off.  

• USB logger readout: Fast readout enabled allows the computer to read out your USB logger 
quickly. Disable this option only if you are having communication problems with the logger. 
Communication between the computer and the logger is slower when this option is turned off. 

Other Options 

• Close the status window on logger disconnect or communication error. When this option is 
selected, the Status window closes automatically (on the next refresh) if it is open when you remove 
the interface cable, base station, or coupler from the logger, or if communication is interrupted for 
another reason. Otherwise, it is left open. (If the Status window was opened from the Launch 
window, it will close automatically even if this option is not selected.) 
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Genera l  P re fe rences  

Launch Time-Saving Options 

See Launch Time-Saving Options 

Readout Time-Saving Options 

See Readout Time-Saving Options 

Open File Time-Saving Options 

When opening a datafile:  

By default, when opening a datafile, HOBOware Pro displays the Plot Setup dialog. To bypass this dialog 
(including Data Assistants) and plot automatically, choose Automatically plot. 

Export Settings 

See "Export Settings" on page  

Selecting Devices 

Normally, when multiple loggers are connected, HOBOware displays a window listing all connected loggers 
every time you choose a logger operation, such as launch, readout, status, or stop. This allows you to 
choose the device you want to work with before continuing with the command, and it ensures that you are 
always working with the logger you expect.  

Only show Select Device window if a device has not been selected 

Select this option if you do not want to be prompted by the Select Device window every time you choose a 
logger operation. You will still be prompted the first time you try to communicate with a logger, but your 
logger selection will remain in effect until you change it manually with the Select Device command on the 
Device menu.  

File Associations 

Click buttons to change file type associations. 

After you install HOBOware LitePro, files with extensions of .hobo, .hsec, .dtf, .dsec, and .hproj are 
automatically associated with HOBOware LitePro. This means that these files are identified by a HOBOware 
LitePro icon and can be opened by double-clicking them.You may want to disable this association to avoid 
conflicts with another software application. To unmap file extensions, click UnMap. To restore the 
association, click Map. 

NOTE: You must have administrator privileges on the computer to change file type associations. 

HOBO file types are: .hobo, .hsec, and .hproj. 

DTF file types are: .dtf and .dsec. 
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 Data Verification 

Enable Secure Mode 

In Secure Mode, HOBOware Pro adds a digital signature to new datafiles when you read out loggers. The 
digital signature is indicated by a filename extension of .hsec for hobo files and .dsec for dtf files. The 
signature will be verified each time you open the datafile to ensure its integrity. This option is turned off 
by default.  
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Launch  T ime-Sav ing  Opt ions  
When launching 

By default, HOBOware Pro displays the launch window when you initiate a launch. If you want to skip the 
launch window and launch the logger with the default settings as described in the Fill launch window 
with contents of preference, choose Automatically launch. This is particularly useful if you want to 
launch many loggers quickly without changing any settings.  

When used in conjunction with a Default Action of Launch, this feature allows you to launch many U-
Series loggers in a row simply by plugging and unplugging individual loggers. 

Fill launch window with contents of 

A logger's memory contains the most recent launch settings for that logger. These settings normally 
become the defaults for the logger's next launch (the Current logger option). However, if you plan to 
launch several loggers of the same model with similar settings, you can change this preference to 
Previous launch. This will fill the launch window with the settings from the previous logger that was 
launched.  

This is particularly useful if you want to set up many loggers to start at the same time and with the same 
logging interval. An indicator on the Launch window will remind you when this preference is in use. 

If the logger you are launching is a different model from the previous logger, Previous launch does not 
apply. HOBOware Pro will use the settings in the logger's memory, and those values will become the 
default for the next logger if it is the same model. 

Default launch type 

This option allows you to set the default starting mode to Launch now, Launch at interval, Delayed 
launch, or Triggered start. The default is Previous launch type, meaning that the launch option will 
default to the option used for the logger's previous launch. (Exception: if the previous launch was an At 
interval start, the next launch will default to a delayed start.) If you want to always default to a specific 
launch option, choose that option from the list.  

Important: If you choose Triggered start as the default launch type, then launch a logger that does not 
offer a trigger start option, the launch option will default to Launch now. 

If you set the Fill launch window with contents of preference to Previous launch, the Default 
launch type setting will be ignored in favor of the start type from the last launch.  
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Readout  T ime-Sav ing  Opt ions  
When saving datafile 

By default, HOBOware Pro displays a save dialog after you read out a file. This allows you to specify a 
location and name for the file, or decline to save the file. If you want to skip the save dialog, choose 
Automatically save. The file will be saved automatically with a default name (based on the launch 
description) and in the default location. 

When plotting 

By default, after reading out a logger and being prompted to save the datafile, HOBOware Pro displays the 
Plot Setup dialog. To bypass this dialog (including Data Assistants) and plot automatically, choose 
Automatically plot. To skip the dialog without displaying the plot (useful if you are reading out many 
loggers now and prefer to look at the plots later), choose Do not plot. 

Ask to stop logging before reading out a running logger 

When this option is selected, a prompt appears every time you read out a logger that is logging, asking 
whether you want to stop the logger or let it continue logging data during readout. If this option is not 
selected, the logger will always continue logging during readout. 

Reading Out Multiple Loggers 

When used in conjunction with a Default Action of Readout, the Readout Time-Saving Options allow you to 
read out many U-Series loggers in a row simply by plugging and unplugging individual loggers. To do this, 
set these options as follows: When saving datafile: Automatically save When plotting: Do not plot Ask to 
stop logging...: Disabled (unchecked) Then, from the Device menu, choose a Default Action of Readout. 
(The Default Action will reset to Do Nothing the next time you start HOBOware Pro.) 



  

- 86 - 

Star tup  Pre fe rences  
Show splash screen on startup 

By default, the splash screen appears when you start , to let you know that the software is loading. If you 
clear this checkbox, the splash screen will not display. 

You can still display it manually by choosing About from the File menu. 

Check for HOBOware updates: 

If you have an Internet connection, can periodically ask if you would like it to check the Onset website for 
updates to HOBOware and associated software. The default is once per week, but you can configure to 
check daily or monthly. 

If you do not have an Internet connection, or if you would prefer to check for updates manually using the 
Check for Updates item on the Help menu, choose Never. 

When checking for HOBOware updates: 

• Notify me of new HOBOware add-on components and updates to my installed components 

By default, when you check for updates, HOBOware Pro informs you of updates to HOBOware Pro 
components that you have installed, and also notifies you if any new HOBOware Pro components 
are available. 

• Notify me of updates to my installed components only 

Select this option if you do not want to be notified of any new components. 
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Expor t  Se t t ings  
Export table data column separator: 

 This setting controls how the columns in the Points table are separated in the export file. It also affects 
the default file type used when exporting points. When Comma is selected as the column separator, the 
default file type is .csv, which can be imported automatically into Microsoft Excel. When Tab or 
Semicolon is selected for the column separator, the default file type changes to .txt instead of .csv, and 
the file will require additional adjustment within Excel.  

Date and time format: Separate into two columns. 

 By default, date and time are exported as a single column to facilitate graphing in spreadsheet programs. 
If enabled, this setting splits the date and time into two columns.  

Include in column header: 

• Logger serial number 

This setting adds the logger's serial number to each column header when you export the Points 
table. This is especially useful if you are exporting series that were copied and pasted from plots 
that came from different loggers.  

• Sensor serial number (if available) 

This setting adds the sensor's serial number, if it has a serial number, to each column header when 
you export the Points pane. This is especially useful if you are exporting data that includes 
similarly-named series that were recorded on different sensors; for example, a HOBO Weather 
Station datafile with data from three temperature sensors. 

Automatically export table data upon reading out of a loggerEnable this setting if you want the data 
to be exported to a separate text file every time a datafile (.hobo$p$ or .dtf$/p$) is saved. (This option 
does not apply to HOBO project files or when reading out a shuttle.) 

•  Bypass Multi-file Export ... 

By default, the data will be exported to a single text file with the same prefix and in the same 
location as the datafile. 

To export multiple files, uncheck this option. 

• Show multi-file export dialog 

Select this option to save the exported data to multiple files, which may be helpful if the datafile is 
very large.  
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WORKING WITH  A  SHUTTLE  

Work ing  w i th  a  Shut t l e  
HOBO shuttles provide a convenient way to read out and relaunch loggers in the field. The HOBO U-
Shuttle features a text display and is compatible with all loggers supported by HOBOware Pro. The HOBO 
Waterproof Shuttle communicates with HOBOware-compatible optic loggers. 

NOTE: To use a U-Series logger (other than the HOBO U30 Station) with a shuttle, the logger must first be 
launched with HOBOware version 2.2 or higher at least once. Consult the shuttle user guide for details. 

HOBOware Pro allows you to launch these shuttles, collect logger data in the field, and offload the 
datafiles from them.  

• Checking shuttle status 

• Shuttle Management dialog 

• Offloading and saving shuttle files 

• Deleting shuttle files 

For detailed instructions on using the shuttles to read out loggers, check logger status, and relaunch 
loggers, refer to the user guide that came with your shuttle. 

U-Shuttle Firmware Updates  

To update your U-Shuttle's firmware, download the firmware update file from the website, then choose 
Update U-Shuttle Firmware from HOBOware Pro's Help menu. 

Re-Launching a Shuttle  

To delete all datafiles and reset the shuttle's clock in one step, click the Launch Shuttle button on the 
Shuttle Management dialog. (If the Shuttle Management dialog is not currently displayed, choose Launch 
from the Device menu.) 

Re-Launching the shuttle also repairs a corrupted header. 
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Check ing  Shut t l e  S ta tus  

Description 

The Shuttle Management dialog displays the status of the shuttle, including battery and clock information, 
and lists the datafiles that have been read out from loggers in the field.  

Steps 

To access the Shuttle Management dialog: 

1. If any loggers are attached to the shuttle, remove them.  

2. Power on the U-Shuttle, if applicable. (The Waterproof shuttle does not need to be powered on.) 

3. Connect the shuttle to the computer as described in the shuttle's user guide.  

The U-Shuttle display should say "PC/Host Connected." The green LED on the Waterproof Shuttle 
should be blinking. 

4. From the Device menu, choose Manage Shuttle or Status.  

5. Choose the shuttle from the Select Device dialog, if applicable.  

6. Review the shuttle's status information.  

NOTE: While the Shuttle Management dialog is displayed, the U-Shuttle remains on battery power for up 
to an hour. After one hour, or any time the U-Shuttle's main battery level becomes low, the dialog closes 
and the shuttle powers down.  

To further conserve the shuttle's battery life, you should close the dialog, disconnect the shuttle, and turn 
the shuttle off as soon as you finish working with it. The Waterproof Shuttle is powered by the USB port, 
and does not need to be turned off. 
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Shut t l e  Management  D ia log  
This topic describes the fields in the Shuttle Management dialog for the U-Shuttle and Waterproof Shuttle. 

Device Type 

Shuttle model and description. 

Serial Number 

Serial number of the shuttle. 

Firmware Version 

Version number of the shuttle's firmware. 

Main Batt Level (AA)  (U-Shuttle only) 

Condition of the shuttle's main batteries. Consult the U-Shuttle User's Guide for specifics on battery 
capacity. 

Clock Batt Level (CR1225) (U-Shuttle only) 

Condition of the battery that provides backup power to the shuttle's clock. Consult the U-Shuttle User's 
Guide for details. 

Battery Level (Waterproof Shuttle only) 

Condition of the shuttle's batteries when you opened the Waterproof Shuttle Management dialog. If the 
batteries are low, remember to change them before going into the field. Consult the Waterproof Shuttle 
User's Guide for specifics on battery capacity. 

Last Launched 

Date, time, and offset to Greenwich Mean Time (GMT, also known as UTC) when the shuttle was last 
launched. 

Computer Clock 

Time reported by the computer's clock. 

Shuttle Clock 

Status of the shuttle's clock in relation to the computer's clock. If the difference is more than five seconds, 
the shuttle clock label and icon will flash red. The shuttle's clock is synchronized to the computer when 
you launch the shuttle or press the Set Shuttle Clock button. 

Set Shuttle Clock 

Click this button to synchronize the shuttle's clock to the computer clock without launching the shuttle. 
(Exit HOBOware Pro if you need to update the computer's clock first.)  

Important: If the difference between the shuttle's clock and the computer's clock is more than 59 
minutes, the Set Shuttle Clock button is not available. You must launch the shuttle to correct the time 
difference. 
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Files on Shuttle 

This panel lists the logger datafiles that are available to be offloaded from the shuttle. If the shuttle 
is empty, this will say "No Files Available on Shuttle." 

Status 

Message that describes the state of the datafile on the shuttle. When HOBOware Pro is offloading a 
file from the shuttle, the status message is replaced by a progress bar.  

• For the U-Shuttle only, the status message AWAITING OFFLOAD appears when HOBOware Pro is 
offloading files from the shuttle, and FINISHED after each file is offloaded. 

• For the Waterproof shuttle only, files have the status message OFFLOADED only if the file has been 
offloaded from the shuttle and saved as a datafile. If the file has not been offloaded, or it has been 
offloaded but not saved, its status is NOT OFFLOADED. 

Logger Type 

Model and description of the logger that logged the data in this file. 

Serial No. 

Serial number of the logger that logged the data in this file. 

Launch Desc. 

Description entered when the logger was launched. This description will be the default datafile name. 

Launch Time 

Date, time, and offset to Greenwich Mean Time (GMT, also known as UTC) when the shuttle was last 
launched. 

File Size 

Actual size of the datafile. 
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Read ing  Out  F i l es  f rom a  Shut t l e  
To read out datafiles from a shuttle: 

1. Connect the shuttle to the computer. 

2. To quickly offload all of the new datafiles that are on the shuttle, choose Readout from the Device 
menu and skip ahead to step 5. Otherwise, choose Manage Shuttle from the Device menu and 
choose files to offload: 

• For the U-Shuttle, all files are selected by default if the shuttle has not been offloaded before. 
To uncheck all files, click the Uncheck All button. To uncheck individual files, click the 
checkbox next to each file. 

• For the Waterproof Shuttle, only the files that have not previously been offloaded and saved 
are selected by default. To check or uncheck individual files, click the checkbox next to each 
file. Use the Check All and Uncheck All buttons next to Previously Offloaded Files and 
New Files (Not Offloaded) to control the selection of these groups of files. 

3. Waterproof Shuttle only: To automatically delete files after you offload and save them, enable the 
Delete Contents Upon Offload option. Files will be automatically deleted only after you 
successfully save them to the host computer. 

4. Click the Offload Checked button to begin offloading the datafiles. (Once offloading begins, the 
Offload Checked button will change to Cancel Offload.) 

5. When offloading is complete, the Files on Shuttle panel on the Shuttle Management dialog will 
change to a Files Offloaded From Shuttle panel. 

6. Accept the default Save Folder, or click Choose to use a different location. The default location 
creates a new folder for the files.  

NOTE: To have the folder automatically open on the desktop after the files are saved, check Open 
Folder in Windows Explorer after Save. 

 
 

7. Choose files to save. (By default, all of the files you offloaded will be selected for saving.) 

• To uncheck individual files, click the checkbox next to each file. To uncheck all files, click the 
Uncheck All button.  

• To save all files (if you have already unchecked a few), click the Check All button.  

• To exit without saving any files, click Cancel Save. 

8. Enter new Datafile Names or accept the defaults (based on the logger descriptions). 

9. Click Save Checked.  

The files are saved to the specified folder. 
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De le t ing  F i l es  f rom a  Shut t l e  
You can delete shuttle files when there is a Files on Shuttle panel on the Shuttle Management dialog. 
You cannot delete shuttle files while the Files Offloaded From Shuttle panel is displayed. If the Files 
Offloaded From Shuttle panel is displayed, you must save the offloaded files (or cancel without saving) 
before deleting any files. 

Deleting Files from a U-Shuttle 

To delete all files from a U-Shuttle, whether they have been offloaded and saved or not, click the Launch 
Shuttle button on the Shuttle Management dialog to launch the shuttle. You cannot delete individual files 
from a U-Shuttle. 

NOTE: Because the shuttle's header information occupies 64 KB, 3.94 MB is the maximum amount of free 
memory available on a U-Shuttle. 

Launching also resets the shuttle's clock and its Last Launched time.  

Deleting Files from a Waterproof Shuttle 

To automatically delete files after you offload and save them, enable the Delete Contents Upon Offload 
option before clicking Offload Checked. Files will be automatically deleted only after you save them. 

To select specific files to delete, click the checkbox for each unwanted file on the Shuttle Management 
dialog. To select all of the files that have already been offloaded, click the Check All button next to 
Previously Offloaded Files. Then click Delete Checked. 

To delete all files from a Waterproof Shuttle, whether they have been offloaded or not, click the Launch 
Shuttle button on the Shuttle Management dialog to launch the shuttle. This will also reset the shuttle's 
clock and its Last Launched time. 
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CONFIGURING FLEXSMART  
MODULES/ANALOG SENSOR PORTS  

Con f igur ing  Modu les/Por ts  
The HOBO Energy Logger Pro is compatible with Onset smart sensors and FlexSmart modules. The HOBO 
U30 Station uses smart sensors and an optional analog sensor port. While smart sensors are designed and 
pre-configured for specific purposes, FlexSmart modules and the analog sensor port are user-configurable 
to accommodate a wide range of Onset and third-party sensors. To take advantage of this adaptability, 
HOBOware Pro lets you configure these modules/ports at launch time, or create and save different 
configurations to be loaded into the modules/ports whenever needed.  

• Creating and saving a configuration 

• Loading a saved configuration or resetting the default 

• Configure Channel dialog 
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Crea t ing  and  Sav ing  a  Con f igura t ion  
To configure an analog sensor port in the HOBO U30 Station or a FlexSmart module in the HOBO Energy 
Logger Pro, take the following steps:  

  

1. Connect the device to the computer. (Refer to the manuals that came with your logger, module, and 
sensors for more specific instructions on how to set up the logger hardware.)  

2. From the Device menu, choose Configure Modules/Ports. (If the logger is already logging, you will 
be warned that the logger will have to be stopped first.) This will display the Select Channel to 
Configure dialog.  

3. If using the HOBO Energy Logger Pro, you can attach additional modules while viewing this dialog. 
Click Refresh to update the module list. Only configurable modules are listed in this dialog. 

4.  Double-click a module/port name to display a list of the available channels. Each channel in the 
module/port is defined by its channel number (the physical order in the module/port), the 
configured channel name, and any location (assigned at launch) defined for this channel in the 
logger. Tip: You can disable one (but not both) of the sensors on a module/port so that it does not 
log, use battery power, or consume memory. Click the sensor channel name to select it, then click 
the Disable button. Click the button again (now displayed as Enable) to re-enable the sensor for 
logging.  

5. Click a channel name to select it, then click Configure to display the configuration dialog for that 
channel. Tip: You can also access the configuration dialog from the Launch window. Double-click the 
module/port name to expand it, click the channel name to select it, and click the Configure button.  

6.  When the Configure Channel dialog appears, change any relevant configurable parameters: - Select 
(or define) Channel Name  

• Set Excitation Power, if applicable  
• Select (or define) Measurement Type, if applicable  
• Set up scaling parameters, including Scaled Units, if applicable For details on each of these 

parameters, refer to “Module configuration parameters”.  

7. To save this configuration for future use with any module/port of the same type, click Save. Enter a 
name for the file and click Save. By default, the file is saved in the My 
Documents\HOBOware\Configs folder with an extension of .hcfg. 

You do not have to save the configuration now if you are going to send it to the module/port right away, 
but you may find it convenient to save the configuration for future use, especially if you have defined 
custom sensor settings.  

8. To send the currently displayed configuration to the module/port now (with or without saving it 
first), click Configure. The module will remain in this configuration until you send a different 
configuration to it.  
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Load ing  a  Saved  Con f igura t ion  
Once you have created and saved a sensor configuration, you can load it into any module/port of the 
same type.  

For example, a configuration for a FlexSmart TRMS module can be loaded into any other FlexSmart TRMS 
module, but not into a FlexSmart Analog module.  

1. Access the configuration dialog as you did in steps 1 through 5 in Creating and Saving a 
Configuration.  

2. Click the Load button. The resulting dialog lists all defined configurations in the currently selected 
folder that are compatible with the module/port. 

3. Choose a configuration: To use one of the defined configurations, click the button next to Use 
Configuration File, then click the button next to the name of the configuration file you want to use. 
Then click Continue.  

If you are experiencing problems with the module, you can reset the channel to its default configuration. 
Select Use Default Module Configuration, then click Continue. 

4. To send the currently displayed configuration to the module/port, click Configure. The module/port 
will remain in this configuration until you send a different configuration to it.  
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Set t ing  Sca l ing  Parameters  
This topic describes the settings for the scaling parameters section of the Configure Channel pane. 

 

Raw  

Units:  

This is the type of output the sensor has; either V or mA, corresponding to the type of sensor selected.  

Raw Value 1 and Raw Value 2 should be input in these units.  

For example, if the external sensor has an output of 4 – 20 mA, the raw units would be in mA.  

Value 1  

The low raw value given by the external sensor. In the previous example, this would be 4 mA.  

Value 2  

The high raw value given by the external sensor. In the previous example, this would be 20 mA.  

Raw Value 2 must always be greater than Raw Value 1.  

Scaled  

Units  

Choose one of the predefined units from the pull-down list, or choose Custom to define units for other 
types of sensors. See Custom Units below.  

Value 1  

The value you will see on the graph when the sensor reports a raw value equal to Raw Value 1. This value 
should be entered in the same units that are specified in the Scaled Units box.  

Value 2 

The value you will see on the graph when the sensor reports a raw value equal to Raw Value 2. This value 
should be entered in the same units that are specified in the Scaled Units box.  

Custom Units  

If you select Custom ... in the Scaled Units drop-down list, the following dialog appears.  
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Enter a description up to eight characters of the units associated with the physical property to be 
measured. For example, if the sensor attached to this channel was a flow meter that measured flow rate, 
you could specify CFS (Cubic Feet per Second) as the scaled unit. If you want to see data in particular SI 
or US units, you need to enter the appropriate scaling values and units here.  

Custom units do not allow for conversion between SI to US units. It is only a reference used to indicate 
how the module is configured and how the resulting data should be labeled.  

Check the Save this value for next time box to have this unit name added to the Scaled Units pull-down so 
that it can be selected in the future when using the same type of module.  

Custom unit names are removed when you restore preference defaults.  

Click OK to return to the Configure Channel dialog.  
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Conf igur ing  Exc i ta t ion  Power  

Description  

The Analog Sensor Ports support optional, user-configurable sensor excitation power and warmup. Sensor 
excitation is a voltage output provided by the HOBO U30 Station to power a sensor that is connected to it. 
This power may be needed because the sensor is not self-powered, or because the sensor’s power 
capacity cannot support a long deployment.  

When sensor excitation is required, the logger can provide 12 V DC sensor excitation voltage up to 200 
mA total for transducers that require external power for proper operation. The excitation voltage has a 
programmable warmup time and is controlled by the Analog Sensor Port.  

A warm up time can be up to 120 seconds. If the warm up required is longer than 120 seconds, or if you 
are not concerned with battery life, you may choose the Continuous option, which will power the sensor 
for the entire deployment. Then click OK to return to the Configure Channel dialog.  

Battery Life  

Providing excitation power drastically decreases the logger's battery life. (Consult the logger manual for 
more information.) In order to save battery power, you may specify the minimum time needed to power 
the sensor before taking a measurement. For example, if you specify a Warm Up of one second and set 
the logging interval in the logger to one minute, the logger will power the external sensor for one second, 
log data and then turn off the excitation power for the next 59 seconds. 

 Always enable the logger's internal battery channel when logging with excitation power. If the battery 
becomes too low to provide excitation power, excitation power is turned off, but logging continues as long 
as the battery can power the logger. This will cause the further readings on that channel to become 
inaccurate. If you are logging the internal battery channel when this happens, an Excitation Off event will 
be shown in your datafile to mark the point at which excitation power was disabled. 

Configuration  

You configure Excitation Power from the Configure Channel dialog. 

1. Click on the Set Excitation Power button to open the Excitation Power dialog.  

2. Check off the Excitation Power Used box.  

3. Select the Mode.  

4. If the Mode is Warm Up, select the warm up time in seconds.  

5. Click OK.  

Modes  

Warm up  

When in Warm up Mode the logger supplies excitation power for a brief, user-programmable period prior 
to each measurement. This mode allows you to select the minimum warm up time needed to allow for 
sensor stabilization, while conserving battery power.  

For example, if you specify a warm up of one second and set the Logging Interval to one minute, the 
HOBO U30 Station will power the external sensor for one second, log a measurement, and then turn off 
the excitation power for the next 59 seconds. The warm up time can be up to 120 seconds.  
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If the warm up time selected is greater than the logging interval selected, the logger will interpret the 
excitation mode as continuous.  

Continuous  

When in Continuous Mode the logger supplies constant excitation power to the sensor for the entire 
duration of the deployment. This mode will result in reduced battery life. Continuous mode is required if 
the sensor needs more than two minutes of warm up time.  

The Analog Sensor Ports begin functioning when logging begins. When the ports are functioning correctly, 
the Active indicator LED on the port blinks once per logging interval to indicate that a successful 
measurement has been made. The Ex. On indicator LED will also be lit when excitation is enabled.  
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HOBOWARE  REFERENCE  

The  Launch  Window:  S ta t ion  Loggers  
The Launch Window for the following Station loggers is shown below: 

• Weather Station 

• Micro Station 

• Energy Station 

• U30 Station (see Working with the HOBO U30 Station on page 25 for more information) 
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Launch  Window Desc r ip t ion :  S ta t ion  
Loggers  
The following table explains the elements in the Launch window for the following loggers: 

• Weather Station 

• Micro Station 

• Energy Station 

• U30 Station 

Field/Description 

Logger Type 

Logger model and description. 

Serial Number 

Serial number of the logger. Note that some external sensors also have serial numbers, which are not 
listed here. 

Deployment Number 

Number of times (including this time) the logger has been launched. Each time you start a new launch, 
the deployment number increases by one. 

Battery or Battery Level 

Condition of the battery when you opened the Launch window. The indicator varies depending on the 
logger model. For example, some loggers require you to specify whether the battery is alkaline or lithium. 
Consult the logger documentation for specifics on battery capacity. 

Description 

Enter a description for the launch, up to 40 characters, in this field. This description is used as the default 
file name when you read out and save the data recorded by the logger. It is also the title of the graph. 

Channels To Log 

Review and configure the data channels, if any, you want the logger to record. If you do not select any 
channels to log, the logger will record states and events only. 

Only the sensors that are currently plugged in or built into the logger are listed. Sensors are listed in 
ascending order by serial number, regardless of their position in the logger. If you add or remove sensors, 
click the Refresh button to make sure your changes are seen by the logger.  

Although it is helpful to see the connected sensors when setting up the launch, it is not required that you 
connect the sensors during launch set-up (though they do need to be connected if you want to define 
locations or configure FlexSmart modules or Analog Sensor Ports). You may set up the launch for a 
delayed or trigger start, then connect the sensors later, before logging begins. 



- 103 - 

Double-click a sensor name (or click the Set Location button while a sensor name is selected) to enter a 
location string, up to 30 characters, that provides useful information about the sensor for this deployment. 

For more information see Channel Configuration Guidelines: Station Loggers on page 18. 

Wrap Around When Full 

You have the option to allow station-type loggers to wrap and continue logging after the memory has filled 
up. The newly logged information will overwrite the oldest logged information. Check this box if you want 
the logger to continue logging, overwriting the older data, instead of stopping when full. 

User Notes 

You may enter up to 2000 characters of information about the deployment. This text will be displayed in 
the Details pane after you read out the logger and display the data. 

Logging Interval 

Choose the rate at which you want the logger to record data. The minimum logging interval is one second 
and the maximum for most loggers is 18 hours, 12 minutes, and 15 seconds. The shorter the logging 
interval, the more quickly the memory fills and battery power is consumed.  

Some sensors (specifically, the FlexSmart TRMS modules) require a logging interval of two seconds or 
greater. If you choose a faster logging interval, erroneous data will be logged on these channels. 

Sampling Interval 

The sampling interval allows you to take multiple measurements within the logging interval, then average 
them together to create a single logged measurement.  

The sampling interval is optional, and is valid only for sensors that support measurement averaging. Refer 
to the sensor's user manual to determine whether your sensor supports measurement averaging. If you 
have at least one sensor that supports measurement averaging, check the box to enable measurement 
averaging, then set the sampling interval at less than or equal to the logging interval (up to four minutes). 
Rapid sampling (faster than one minute) will reduce the logger's battery life.  

If you do not have any sensors that support measurement averaging, uncheck the box to disable the 
sampling interval and avoid unnecessary strain on the logger's battery. 

Logging Duration 

Approximate time it would take to fill the logger's memory based on the logging interval and the currently 
connected and enabled sensors, if applicable. This is a theoretical estimate only; battery life will affect 
your deployment. In addition, if you plan to connect additional sensors before logging begins (i.e. while 
awaiting a trigger or delayed start), the estimate will not be correct.  

If you add or remove sensors while viewing the Launch window, click the Refresh button to get an 
updated Logging Duration.  

Launch Options 

NOTE: See Working with the HOBO U30 Station on page 25 for additional details on launching the 
HOBO U30 Station. 

There are several ways to start the logger: 

• Now 
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 Logging begins as soon as you click the Launch button. If you do not have at least one sensor 
attached, the logger will not launch. 

• At Interval 

Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when you choose 
a one-hour logging interval). The exact start time depends on the logging interval you choose. 

• Delayed 

Logging will begin at a date and time you specify. 

• Trigger 

Logging will not start until you press the button on the logger and hold it down, or perform some 
other action as described in the logger manual. If the logger has a light, the light will flash quickly 
when logging begins. This is not available for the U30 Station. 

• Save Settings 

Logging will not start, but the launch settings will be saved so that you do not have to re-enter 
them when you are ready to launch at a later time. The next time you view the Launch window for 
this logger, the settings you entered will still be in place. 

Tip: The Launch Option defaults to the option selected for the current logger's previous launch. Use the 
Default launch type  preference to change this setting if you always want all loggers to default to the 
same launch option. On the General pane, go to Launch Time-Saving Options and select a launch 
option from the Default launch type list. 

Skip launch window next time 

Check this box if you would like to bypass this window the next time you choose Launch from the Device 

menu or click the Launch icon . This will cause the next logger to be launched with default settings, as 
determined by the Fill launch window with contents of preference. 

To turn this setting off so that you can access the Launch window again, go to Preferences. On the 
General pane, go to Launch Time-Saving Options and select "Show launch screen" from the When 
launching list.  

NOTE: A note on the Launch window "*Default window contents obtained from Last Launch" indicates that 
the Fill launch window with contents of Previous launch preference is enabled. If you want to always 
use the settings from the logger's memory, you can return to the default setting. In Preferences, click the 
General icon, and choose Fill launch window with contents of Current logger under Launch Time-
Saving Options. 
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Channe l  Con f igura t ion  Gu ide l ines :  
S ta t ion  Loggers  
This topic describes guidelines for the Channels to Log section in the Launch window for Station loggers. 

Some general information is given below, but you should always refer to the documentation that came 
with your logger for detailed information about the channels that are available to you. 

Dew Point 

When a sensor includes both temperature and RH, dew point will be calculated automatically. 

Maximum Channels 

Do not attach more than 15 channels of sensors. The logger cannot accommodate more than 15 channels. 

Battery Channel 

In addition to logging up to 15 channels, the HOBO Energy Logger Pro and HOBO U30 Station can record 
their internal battery channel. (Other sensors must be attached; the logger cannot log battery alone.) The 
logger's battery voltage is recorded at each interval.  

Like the other data channels, logging the internal battery channel consumes some of the logger's memory. 
Unless you are using excitation power or suspect abnormal battery performance, you probably do not 
need to log the battery voltage in loggers other than the HOBO U30 Station. 

Excitation Power 

Always enable the logger's internal battery channel when logging with excitation power. This will enable 
you to determine whether and when excitation power was turned off during a deployment. 
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The  Launch  Window:  U-Ser ies  Loggers  
The Launch Window for all U-Series loggers except the U30 Station is shown below. 

See Error! Hyperlink reference not valid. on page 107 for more information. 
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Launch  Window Desc r ip t ion :   
U -Ser ies  Loggers  
The following table describes the fields in the Launch window for all U-Series loggers except the U30 
Station. 

For the HOBO U30 Station Launch Window see Working with the HOBO U30 Station. 

Logger Type 

Logger model and description. 

Serial Number 

Serial number of the logger. Note that some external sensors also have serial numbers, which are not 
listed here. 

Deployment Number 

Number of times (including this time) the logger has been launched. Each time you start a new launch, 
the deployment number increases by one. 

Battery Level/Battery State 

Condition of the battery when you opened the Launch window. Consult the logger documentation for 
specifics on battery capacity. 

Description 

Enter a description for the launch, up to 40 characters, in this field. This description is used as the default 
file name when you read out and save the data recorded by the logger. It is also the title of the graph. 

Event & State Channels (not on all loggers) 

If your logger supports external events and/or states, you can enter names to identify the event and state 
channels that are in use. You can also rename the Open and Closed descriptions for each state, and enter 
increments and units for each event channel. 

Channels to Log 

Select the data channels, if any, you want the logger to record. 

Only the sensors that are currently plugged in or built into the logger are listed. If you add or remove 
sensors, click the Refresh button to make sure your changes are seen by the logger.  

Although it is helpful to see the connected sensors when setting up the launch, it is not required that you 
connect the sensors during launch set-up (though they do need to be connected if you want to define 
locations or configure FlexSmart modules or Analog Sensor Ports). You may set up the launch for a 
delayed or trigger start, then connect the sensors later, before logging begins. Important: Sensors that 
are connected after logging begins will not log any data. 

For more information see Channel Configuration Guidelines: U-Series Loggers on page 110. 
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Logging Interval 

Choose the rate at which you want the logger to record data. The minimum logging interval is one second 
and the maximum for most loggers is 18 hours, 12 minutes, and 15 seconds. The shorter the logging 
interval, the more quickly the memory fills and battery power is consumed.  

• If you did not select any channels to log, this field will be dimmed and unavailable. 

• Set up multiple logging intervals, if available. 

• Set up fast logging intervals, if available. 

  

Logging Duration 

Approximate time it would take to fill the logger memory based on the logging interval and currently 
enabled sensors, if applicable. This is a theoretical estimate only; battery life and frequent state and event 
logging will affect your deployment. If you are logging only state changes and events, no estimation is 
possible. 

Launch Options 

NOTE: The Launch Option defaults to the setting for the logger's previous launch. If you want all loggers 
to default to the same launch option, see Launch Time Saving Options.  

• Now 

 Logging begins as soon as you click the Launch button. 

• At Interval 

Logging will begin at an exact interval (for example 9:00:00 rather than 8:47:00 when you choose 
a one-hour logging interval). The exact start time depends on the logging interval you choose. 

• Delayed 

Logging will begin at a date and time you specify, up to approximately six months from the 
present. 

• Trigger 

 (Available only on certain loggers.) Logging will not start until you press the button on the logger 
and hold it down for at least three seconds, or return the logger to the coupler without the base 
station for at least three seconds (refer to your logger manual for more information). If the logger 
has a light, the light will flash quickly when logging begins. 

Skip launch window next time 

Check this box if you would like to bypass this window the next time you choose Launch from the Device 
menu or click the Launch icon. This will cause the next logger to be launched with default settings, as 
determined by the Fill launch window with contents of preference.  

To turn this setting off so that you can access the Launch window again, go to Preferences. On the 
General pane, go to Launch Time-Saving Options and select "Show launch screen" from the When 
launching list.  

 A note on the Launch window "*Default window contents obtained from Last Launch" indicates that the 
Fill launch window with contents of Previous launch preference is enabled. If you want to always 
use the settings from the logger's memory, you can return to the default setting. In Preferences, click the 
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General icon, and choose Fill launch window with contents of Current logger under Launch Time-
Saving Options. 
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Channe l  Con f igura t ion  Gu ide l ines :  U -
Ser ies  Loggers  
RH/Pressure 

Some loggers with RH or pressure sensors require that you also select the internal temperature channel in 
order to log relative humidity or pressure. Refer to the manual that came with your logger for additional 
information. 

Dew Point 

When both the internal temperature and RH channels are selected, dew point will be calculated 
automatically. 

External Channels 

For loggers with external channels, you must select the part number of the sensor that is attached to 
ensure data is accurate during logging. The sensor part number is listed on the shrink tube on the sensor 
cable; make sure it matches the part number you select. 

If you select an external channel, but do not plug the sensor in, false data will be recorded for that 
channel. 

Utilities 

If applicable, select a channel and click on the Scaling or Alarms button in the Utilities section to configure 
scaling or alarms. 

Battery Channel 

You can select the logger's internal battery channel. The logger's battery voltage is recorded at each 
sample time.  

Like the other data channels, logging the internal battery channel consumes some of the logger's memory. 
Unless you suspect abnormal battery performance, you probably do not need to log the battery voltage. A 
U-Series logger (other than a HOBO U30 Station) will record a bad battery event, even if it is not 
recording the battery channel. 
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The  Con f igure  Channe l  D ia log  
This topic describes the elements in the Configure Channel dialog. 

Module Name 

FlexSmart module model and description. 

Firmware Version 

Version number of the module's firmware. 

Serial Number 

Serial number of the module. 

Channel Number 

Physical order of the channel in the module, starting at 1. 

Channel Name 

Description, up to 16 characters, of the physical property this sensor will measure. For example, if the 
external sensor attached to this channel was a flow meter, you could specify Flow rate as the measured 
property. Choose one of the predefined names from the pull-down menu, or choose Custom to display a 
dialog that allows you to define a new name.  

If you check the Save this value for next time box, the name will be added to the Channel Name pull-
down menu so that it can be selected in the future when using the same type of module. Saved names are 
stored as preferences, and are removed when you restore preference defaults.  

Click OK to return to the Configure Channel dialog. 

Excitation Power 

Some modules can supply power to attached sensors using the logger's battery.Click the Set Excitation 
Power button to display the Excitation Power dialog. Check the Excitation Power Used box to enable 
excitation power and then select the mode. See Configuring Excitation Power on page 99. 

Measurement Type 

Native measurement recorded by the module, if applicable. Some modules support multiple types of 
native measurements. For example, the FlexSmart Analog module can measure either current or voltage. 
If your module offers more than one type of input, select the correct one for your sensor. 

Scaling Parameters  

See Setting Scaling Parameters on page 97. 



  

- 112 - 

The  S ta tus  Window 
This topic describes the elements in the Status window: 

 

Device Identification 

Device 

Logger model and description. 

Manufacturer 

Manufacturer of the logger. 

Description 

Description entered when the logger was last launched. This description will be used as the default file 
name and the title in the graph. 

Serial Number 

Serial number of the logger. 

Firmware Version 

Version number of the logger's firmware. 

Device Details 

See page 114. 
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Current Readings 

See page 116. 

  

Contact HOBOlink 

For the HOBO U30 Station only, a Contact HOBOlink button appears at the bottom of the Status window. 
Click this button when you want the HOBO U30 Station to connect to HOBOlink. When you click Contact 
HOBOlink, a confirmation message is displayed. Once you click Yes, the Status screen will close and then 
the HOBO U30 Station will attempt to connect to HOBOlink within 30 seconds. A warning may appear in 
the event that a live connection with HOBOlink is already underway. 
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Dev i ce  Deta i l s  
This topic describes the elements of the Device Details section of the Status window. 

  

Battery Level/Battery State 

Condition of the battery. Consult the logger documentation for specifics on battery capacity. 

Memory Used 

Percentage of the logger's memory that is full.   

Note: If the battery died while the logger was logging, this will be 100% even if only a small amount of 
the memory was used. 

Wrap Around When Full 

•  Enabled 

•  Disabled 

Wrap Count 

For Station loggers only, this indicator lists the number of times the logger has wrapped, if wrapping is 
enabled. 

Current Status 

Messages that describe the state of the logger. 

In addition, the current state of the relay is described for the HOBO U30 Station. After the state of the 
logger, the message “Relay is open” or “Relay is closed” will display. 

• Awaiting Button/Coupler Start  
The logger has been launched with a trigger start (if available). Press and hold down the button on 
the logger for three seconds to begin logging, or follow the instructions that came with your logger if 
it offers a triggered start but does not have a button. If the logger has a light, the light will flash 
quickly when logging begins. 

• Awaiting Delayed Start 
The logger will begin recording data at a specific time because either Delayed Start or Start at 
Interval was chosen at launch. 

• Launched, Logging 
The logger has been launched and is actively recording data. 

• Logger Is Full 
 The logger has reached its memory capacity and is no longer recording data.  

• Logger is stopped 
The logger is not logging, is not full, and is not awaiting a delayed or trigger start.  

• On Hold for Later Launch 
The logger has been launched with a Save Settings start (if available). Logging is not scheduled to 
begin, but the launch settings have been entered and saved. 
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Last Launched 

Date, time, and offset to Greenwich Mean Time (GMT), also known as Coordinated Universal Time (UTC), 
when the logger was last launched. This is not necessarily the time when the first sample was recorded; it 
is the time all of the launch parameters were loaded in the logger. 

Delayed Start (if applicable) 

If the logger has been launched, but is waiting for a delayed or interval start, the scheduled start time is 
shown here in local time. 

Deployment Number 

Number of times the logger has been launched. The number listed includes the most recent launch. 

Logging Interval 

Rate at which the logger was set up to record data the last time the logger was launched, if applicable. If 
the logger supports multiple logging intervals, the interval currently in use (if the logger is logging) will be 
shown in bold. 

Sampling Interval 

For station loggers only, this is the sampling interval that was entered the last time the logger was 
launched, if applicable. 

Current States (U-Series loggers except the U30) 

If your logger has an event button, most often the current state will be Button Up, meaning the button is 
not being pressed. 



  

- 116 - 

Cur rent  Read ings  
This topic describes the elements of the Current Readings section of the Status window. 

  

Screen Refresh Interval  

Frequency with which the Current Readings are updated, up to 3600 seconds (one hour). A higher 
number means less stress on the logger's battery. The Status icon blinks when the readings are updated. 

Note: For event/state loggers, the interval is set to 0.5 seconds and cannot be adjusted. This ensures that 
you do not miss events and state changes that take place between refreshes. 

Tilt meters (not labeled) 

For acceleration loggers only, color-coded meters display X, Y, and Z-axis tilt (relative to vertical, 
assuming that the only acceleration force on the logger is gravity) graphically. 

Sensor Readings 

Sensor readings, updated in real time.  

• Readings are displayed for all available sensors, even if they are not being logged. If a channel is 
not being logged, its name is dimmed in the display. 
 
 For station loggers, the location (if defined) is displayed next to the reading. 

• If a U-Series logger (other than a HOBO U30 Station) has channels for external sensors, a 
description and reading will be given for the external channels even if no sensors are plugged in. 

• For event loggers, the event count in the Current Readings box will always start at zero, even if 
many events have already been logged.  

• If a HOBO U30 Station has an Analog Sensor Port, readings for one or both channels are displayed.  

• The RSSI (Signal Level) is displayed for the HOBO U30/GSM Station. This helps you determine if 
there is enough signal strength in the current location for the HOBO U30 Station to contact a cellular 
tower for connecting with HOBOlink. Signal level is measured on a scale of 0 to 10, with 0 being no 
signal, 1 being a weak signal, and 10 being a strong signal.  

• The battery voltage is displayed for some loggers. 
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The  P lo t  Se tup  D ia log  
After you read out a logger or open a saved datafile, the Plot Setup dialog appears. 

 

1. Select the series you wish to view on the plot. Click each checkbox individually to select or clear 
sensor measurements, states, and events, or click the All or None buttons to select or clear all 
sensor measurements, states, and events. 

2. Select the units you want to display for each series, if available. 

3. Adjust the time zone offset, if necessary. By default, data is shown in the offset used to launch the 
logger with HOBOware Pro(not by a shuttle). To select a different offset, enter the hours offset from 
GMT (UTC) in decimal form. You may find this useful if you logged in multiple time zones, or if you 
took the logger to a different time zone after launching it. 

4. If data assistants are available, you can use them to create additional series. Select an assistant 
from the list and click Process. 

5. When you have made your selections, click the plot button. The plot is displayed. 
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The  Deta i l s  Pane  
For each sensor measurement, event, and state series, the Details pane contains information and 
statistics, including: 

•  Logger information, such as the logger model and serial number 

•  Sensor information (for station-type loggers), including the sensor location, serial number, and 
resolution 

Tip: If you do not want plots to open with the sensor location shown in the Points and Details panes, 
disable the "Include sensor Location (if available) in points table and details pane" setting under Points 
Table & Details Pane on the Plotting Preferences pane. 

•  Deployment information, such as the launch description, deployment number, start time and time 
zone, logging interval, and battery voltage at launch 

•  Series statistics, including the total sensor samples and events, time of the first and last sample, 
and the maximum, minimum, average, and standard deviation for each sensor series in the plot 

•  Audit trail information for secure (.hsec and .dsec) files 

To fully expand the details tree, click the Show All button. To fully collapse the tree, click Hide All. 

Click a series node in the details tree to select the corresponding series on the graph and corresponding 
column in the Points pane. 

To print the details tree, go to the File menu and choose Print Details. To export the details tree to a text 
file, go to the File menu and choose Export Details. 

To resize the pane, drag the divider between the Details pane and the graph. 

You can hide the Details pane. From the View menu, choose Details Pane. Choose Details Pane again to 
redisplay the Details pane.  

Tip: If you do not want the Details pane to be displayed by default when you view data, go to 
Preferences. On the Plotting pane, in Layout, disable the "Show the details pane when plotting data" 
option. 
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Too lbar  i cons  
The toolbar, located at the top of the main HOBOware Pro window, allows point-and-click access to 
HOBOware Pro's most frequently used functions. Pause the pointer over each icon on the toolbar for a 
description of each tool. 

 Launch - opens the Launch window. 

 Readout - opens the Readout window. 

 Status - opens the Status window, which displays the logger's state and current readings. 

 Stop - stops a logging logger. 

 Select Device - opens the select Device window, which displays available devices. 

The accompanying pulldown menu allows you to specify whether you want HOBOware to look for USB 
devices, serial devices, or both. 

 Open launches the Open dialog, from which you can open HOBOware files. 

 Save - opens the Save dialog, from which you can save the plot as a project (.hproj) file. 

 Close - closes the currently focused plot. 

 Export - Opens the Export Options dialog, from which you can configure settings for exporting a text 
file of the data (in .csv or .txt format) for use in spreadsheet and other applications. 

 Print - prints the graph as it appears on your screen. 

 Arrow - Launches the Arrow Tool, which you can use to point to and select items on the graph to edit 
their properties. 

 Crosshair - Launches the Crosshair Tool, which you can use to display values for points on the graph 
and cross-references them to cells in the Points pane. 

 Hand - Launches the Hand Tool, which you can use to scroll an axis or the entire graph. 

 Zoom - Launches the Zoom Tool, which you can use to adjust the scaling of an axis or the entire 
graph. 

 Subset statistics - Launches the Subset Statistisc Tool, which you can use to view statistics for a 
particular time span. 

 In - Launches the Zoom In Tool, which allows you to zoom in on a smaller area of the graph. 

 Out - Launches the Zoom Out Tool, which allows you to zoom out to a larger area of the graph. 

 Show graph at full scale - Resets the scale of a graph to accommodate all of the displayed data. 
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 Graph Properties - Opens the View Properties window which allows you to modify the properties of 
various graph items. 

 Vertical Gridlines - toggles vertical gridlines on or off. 

 Horizontal Gridlines - toggles horizontal gridlines on or off. 

Mark Points - toggles point markers on or off. 

 Units - Opens the Convert Plot dialog, which allows you to convert some or all of the series on the 
currently focused plot to other units (for example, from degrees Fahrenheit to degrees Celsius). 

 - Help opens the WebHelp. 
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MAINTENENCE  

HOBOware  so f tware  updates  
If you have an Internet connection, HOBOware Pro can periodically ask if you would like it to check the 
Onset website for software updates.  

The default is to check once per week, but you can configure HOBOware Pro to check daily or monthly. In 
Preferences, go to the Startup group on the General pane to change the Check for HOBOware updates 
setting. (If you do not have an Internet connection, choose Never.) 

You may check for updates manually at any time. Choose Check for Updates from the Help menu. 


